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1.0. Introduction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

Gift Xpress is software where you can design gifts in easy way with ready designs provided in the 
software. This software has various ready gift categories like Mug, Mousepad, T-Shirt, Key-
Chain, Cap, Water Bottle, Pillow, Puzzle, Laptop Sleeve, Multi Photo Clock, Photo Collage and 
Phone Cover. Choose or make your own design with photos of you and your loved ones on it. 
Your Gift will always stand out, stored for life, seen and shown many times guaranteed. 
This manual explains the features and uses of Gift Xpress in detail and will serve as your guide as 
you navigate the world of easy and instant Gift creation.  
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2.0. System Requirements 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

 
Windows System 

 
 Pentium 4, 2.8 GHz Processor and above 
 Microsoft Windows XP (service pack 2)/ Microsoft Windows 7 / Microsoft Windows 8 
 1 GB RAM 
 1 GB free disk space 
 CD/DVD- ROM drive 
 Internet  

 
 

MAC System 
 
 Mac Intel, min 1 GHz 
 Mac OS X 10.8.5 and above 
 1 GB RAM 
 1 GB free disk space 
 CD/DVD-ROM drive 
 Internet  
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3.0. Opening the Tool Box 

– Getting Started 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

This section deals with registration process and other tools like controls and navigations, 
preferences and help. 
 

 

3.1. Registration  
  

3.2. Re-Registering the Software on another 
Computer 

 
3.3. Know your Software 

 
3.3.1. What is new? 
3.3.2. General Features 
3.3.3. Controls & Navigations 
3.3.4. Preferences 
3.3.5. Shortcut Tools 
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3.1. Registration 
 
 
 
 
Once you have installed the Gift Xpress software on your computer, you need to proceed to Registration. 
This ensures that all features of the software are made available to you. Registration is very easy and the 
user-friendliness of the software makes the process quick and simple. 
On installation of Gift Xpress, the Registration window appears on your screen. All the fields are 
mandatory. Fill in the details and proceed as per the instructions in this section. 
The software enables you to complete the registration process while you are connected to the Internet. It 
also allows you to register at a later date. 
The screen that you first see on starting the software needs to be completed as a first step. Here is how: 
 

 Enter your details in the relevant fields. These are Name, Email and Phone or Mobile number .  
 

 In the last field-, Serial Number (XXXXX-XXXXX-XXXXX-XXXXX) will be automatically generated in the serial 

number text box . You will also find the serial number inside the software box pack. 
 

 Click on the ‘Buy Now’ button  to buy the complete version of Gift Xpress if you have installed the trial 
version. 
 

 
‘Registration’ window 

 

 After ensuring that all the fields are filled correctly, click on ‘Register’ in the lower right-hand corner. 
 

 To register the software at a later date, click on ‘Register Later’ option . 
 

 The message confirming completion of the registration process appears on the screen. 
 

 For any query and assistance, feel free to connect with us via; 
 
Phone: +1-732-543-7676 Email: support@dgflick.com Web: www.dgflick.com  
 

 You are now registered and can use the software.   

xxx@xxx.xxx 

XXXXX               XXXXX                 XXXXX                XXXXX 

mailto:support@dgflick.com
http://www.dgflick.com/
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3.2. Re-registering the Software 

on another Computer 
 
 
The licensed version of Gift Xpress can be re-registered on any other Computer.  
 

 In case you want to use the software on any other computer, firstly, install the software on the computer on 
which you want to use it. 
 

 After installation, connect the dongle * to the computer and fill the registration form. While filling up the 
registration form, enter the same email address you used while registering the software for the very first 
time.  
 

 After filling up the form, click on the ‘Register’ button. You will get an alert stating, ‘It seems the license is 
already registered on other system. Do you wish to transfer the license to this system?’ 
 

 If you want to re-register the software on this system, click on ‘Yes’ or else to cancel the operation, click on 
‘No’. 
 

 When you click ‘Yes’, you get a mail on the registered email. This email contains a link. Click on the link to 
unregister the software from previous system. You will be redirected to a web page where you will get a 
confirmation that license is ready to transfer to the new system. 
 

 Now you can register the software on new computer by clicking on ‘Register’ option. 
 
 
 
 
 
 
  

Note: Dongle is applicable only for PRO version users. Dongle can be found in PRO version box pack. 
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3.3. Know the Software 
 
 
 
 
This section gives you a basic understanding of Gift Xpress before you actually start working on the 
software. Running through this section will enhance your understanding of the options available and will 
help you to make finest use of the software. 
 
 

3.3.1. What is new? 
 
 
Every new version makes you more creative with new features. In this version of Gift Xpress, we have 
added some interesting features that enhance the workability of the software and serve you with the tools 
that add to your comfort while you work in Gift Xpress. This section makes you familiar with the newly 
added features. 
 

 Quicker access to hot folders: Now access photos faster than ever. Quick access for photo locations like 
Desktop, My pictures and My Documents. 
 

 Improved Interface: New version brings improved interface for you. New look and feel enhancing your 
experience of Gift designing. 
 

 Textures to fill titles and shapes: New feature to fill titles and shapes with textures. Now filling of titles and 
shapes are not restricted up to solid color. Besides, Gift Xpress provides 50 ready presets of textures, which 
can be used or your own textures can be imported. The texture can be filled in tiled or stretched style. 
 

 A brand new 'Title' tab: The 'Title' tab has been changed and giving you newer weapons. Any language title 
writing to make it personalize. Now you can manage the size of the title by just dragging the title. Apart 
from the solid colors and ready presets, you can fill the title with any texture. Manage the fill in tiled and 
stretched way. Customize title further with outline and shadow. Experience the real magic by exploring 
'Title' tab. 
 

 Choice of Mirror output: Checkbox to define your mirror preference. Checking a checkbox will reverse the 
image and will be available in mirror format.  
 

 Multi touch enabled software: Feel the magic of Gift Xpress in touch screen enabled devices. Gift Xpress 
now supports multi touch reading. 
 
 

3.3.2. General Features 
 
 
Gift Xpress comes with several features, which are discussed in this section: 
 

 In-built Standard Gift Sizes: Gift Xpress comes loaded with several in-built Gift types predefined according 
to the standard industry printing specifications. 
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 Ready-to-Use Designs: Gift Xpress has various inbuilt Designs. Ready set of designs can be filtered occasion 

wise, photo count wise, color, orientation & style wise. In addition, DgFlick releases new downloadable 
Designs on a regular basis. Moreover, more than 100 decors are also available along with the software.  
 

 Design Creation and Alteration: Customization of designs according to your desire with the help of decors. 
Create complete new composition or alter ready one and save * for further use. 
 

 Online Cropping: The online photo crop feature allows you to trim out any part of the source photo that 
you do not need. You can crop the photo to give it the desired height and width. 
 

 Photo Editing: Gift Xpress lets you enhance the quality of the photos that make up the Gift. It also allows 
editing of multiple photos * at a time.  
 

 Interactive User Interface: Navigation through the software is simplified by user-friendly controls and 
virtually no training is required before use.  
 

 Multilingual: Gift Xpress is already loaded with multiple languages. You can read the software in the 
language of your comfort from DgFlick’s language pack. It supports Unicode. DgFlick keeps adding to its list 
of languages that Gift Xpress works on. You could download the latest dictionary, which may include the 
language you are looking for. Else, you could add the language of your choice to DgFlick’s dictionary for your 
own use. 

 
 Available on Windows and Mac: Gift Xpress works on both Mac and Windows systems. DgFlick releases 

the updates for both versions simultaneously. 
 

 
 
 
 
 

3.3.3. Controls & Navigations 
 
 

Icon Meaning Icon Meaning Icon Meaning 

 Preferences  Photo is locked  
Equal spacing 

between objects 

 Help  
Photo is unlocked and can 

be modified  Equal size photos 

 Adjust size  Zoom in  
Group/Ungroup 

Objects 

 
Go to the home 

page  Zoom out  Rotate 

 
Move back to the 
previous window  

Photo is not of very good 
quality but can be used  Load original image 

 
Go to the next 

window  
Photo is of bad quality but 

can still be used  Save the work 

 Create  Photo is unfit for use  Save as 

 
Edit  Fit to screen  Reset 

 Delete  Actual size , ,  
Rotate in 90, 180 

and 270 

Note: Features marked with * marks are only for PRO version users. 
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Select path for 

browsing  Swap photo and  
Rotate clockwise and 

counter clock wise 

 Undo  Lock/unlock  and  
Flip horizontally and 

vertically 

 Redo  Arrange objects  Panning 

 
Show/hide 

margins  
Page-based alignment  Full Screen View 

 
Show/hide 

gridlines  Object-based alignment  and  Edit Photo 

 
 
 

3.3.4. Preferences 
 
 

Gift Xpress gives you great flexibility in usage while working on it. You could  
 

 Change the language of your choice. 
 
 Select the desired Theme for your software. 

 
 Select the desired tab layout for ‘Design Gift’ window. 

 
 View/Hide tools for precise working area. 

 
After installation, click on the Gift Xpress shortcut icon 
to start the software. 

 
‘Preferences’ window 

 

 Clicking on the ‘Preferences’ icon  on the top right-hand corner, displays the ‘Preferences’ window. 
 

 Choose your preferred language from various available languages in ‘Language’ tab, click on ‘Check for 
Updates’ to check the updated list of languages.  

 
 Select the color in which you want the software to be displayed from ‘Theme’ tab, click on ‘Get More’ to get 

more themes from DgFlick’s website. 
 

 From ‘Layout’ tab, you can change the layout of 
‘Design Gift’ window i.e. canvas area of the 
software. You can align tabs to left, right and 
bottom style. 
 

 
‘Preferences’ window – ‘Layout’ tab 

 
 ‘View’ tab allows you to show/hide additional tools. Check the tools which you want to make visible. 

Uncheck the unwanted tools. 
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‘Preferences’ window – ‘View’ tab 

 
 Save your changes by clicking on ‘Ok’. You might need to restart your software for the changes to take effect.  

 
 Click on ‘Help’ to get the help menu. It has a complete list of shortcut keys that you will find useful while 

using the software 
 
 
 

3.3.5. Shortcut Tools 
 
 

Gift Xpress - Shortcut Keys 

Object 
Type 

Actions Windows Mac 

All 

Move – Left Left Arrow key Left Arrow key 

Move – Right Right Arrow key Right Arrow key 

Move – Top Top Arrow key Top Arrow key 

Move – Bottom Bottom Arrow key Bottom Arrow key 

Move – Left + Snap CTRL + Left Arrow key COMMAND + Left Arrow key 

Move – Right + Snap CTRL + Right Arrow key COMMAND + Right Arrow key 

Move – Top + Snap CTRL + Top Arrow key COMMAND + Top Arrow key 

Move – Bottom + Snap CTRL + Bottom Arrow key COMMAND + Bottom Arrow key 

Photo 

Crop – Zoom In ALT + '+' ALT + '+' 

Crop – Zoom Out ALT + '-' ALT + '-' 

Crop – Left Pan ALT + Left Arrow key ALT + Left Arrow key 

Crop – Right Pan ALT + Right Arrow key ALT + Right Arrow key 

Crop – Top Pan ALT + Top Arrow key ALT + Top Arrow key 

Crop – Bottom Pan ALT + Bottom Arrow key ALT + Bottom Arrow key 

Crop – Before Page Up Page Up 

Crop – After Page Down Page Down 

All 

Rotate X Increase ALT + X ALT + X 

Rotate X Decrease ALT + CTRL + X ALT + COMMAND + X 

Rotate Y Increase ALT + Y ALT + Y 

Rotate Y Decrease ALT + CTRL + Y ALT + COMMAND + Y 

Rotate Z Increase ALT + Z ALT + Z 

Rotate Z Decrease ALT + CTRL + Z ALT + COMMAND + Z 

All 

Arrange Object – Bring To Front SHIFT + Top Arrow Key SHIFT + Top Arrow Key 

Arrange Object – Bring Forward SHIFT + Right Arrow key SHIFT + Right Arrow key 

Arrange Object – Send to Back SHIFT + Bottom Arrow key SHIFT + Bottom Arrow key 

Arrange Object – Send Backward SHIFT + Left Arrow key SHIFT + Left Arrow key 

All Align Page based – Top Left CTRL + 7 COMMAND + 7 
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Align Page based – Top Center CTRL + 8 COMMAND + 8 

Align Page based – Top Right CTRL + 9 COMMAND + 9 

Align Page based – Center Left CTRL + 4 COMMAND + 4 

Align Page based – Center CTRL + 5 COMMAND + 5 

Align Page based – Center Right CTRL + 6 COMMAND + 6 

Align Page based – Bottom Left CTRL + 1 COMMAND + 1 

Align Page based – Bottom 
Center 

CTRL + 2 COMMAND + 2 

Align Page based – Bottom Right CTRL + 3 COMMAND + 3 

Align Page based – Top CTRL + T COMMAND + T 

Align Page based – Bottom CTRL + B COMMAND + B 

Align Page based – Left CTRL + L COMMAND + L 

Align Page based – Right CTRL + R COMMAND + R 

All 

Align Object based – Top Left CTRL + SHIFT + 7 COMMAND + SHIFT + 7 

Align Object based – Top Center CTRL + SHIFT + 8 COMMAND + SHIFT + 8 

Align Object based – Top Right CTRL + SHIFT + 9 COMMAND + SHIFT + 9 

Align Object based – Center Left CTRL + SHIFT + 4 COMMAND + SHIFT + 4 

Align Object based – Center CTRL + SHIFT + 5 COMMAND + SHIFT + 5 

Align Object based – Center Right CTRL + SHIFT + 6 COMMAND + SHIFT + 6 

Align Object based – Bottom Left CTRL + SHIFT + 1 COMMAND + SHIFT + 1 

Align Object based – Bottom 
Center 

CTRL + SHIFT + 2 COMMAND + SHIFT + 2 

Align Object based – Bottom 
Right 

CTRL + SHIFT + 3 COMMAND + SHIFT + 3 

Align Object based – Top CTRL + SHIFT + T COMMAND + SHIFT + T 

Align Object based – Bottom CTRL + SHIFT + B COMMAND + SHIFT + B 

Align Object based – Left CTRL + SHIFT + L COMMAND + SHIFT + L 

Align Object based – Right CTRL + SHIFT + R COMMAND + SHIFT + R 

All 
Equal Spacing Horizontally CTRL + SHIFT + H COMMAND + SHIFT + H 

Equal Spacing Vertically CTRL + SHIFT + V COMMAND + SHIFT + V 

All 

Move Selection to Next Object TAB TAB 

Move Selection to Previous 
Object 

SHIFT + TAB SHIFT + TAB 

Add Next Object to current 
Selection 

CTRL + TAB COMMAND + TAB 

Add Previous Object to current 
Selection 

CTRL + SHIFT + TAB COMMAND + SHIFT + TAB 

All 

Select All Objects on page CTRL + A COMMAND + A 

Cut Object(s) CTRL + X COMMAND + X 

Copy Object(s) CTRL + C COMMAND + C 

Paste Object(s) CTRL + V COMMAND + V 

Delete Object(s) DEL DEL 

Undo Object(s) CTRL + Z COMMAND + Z 

Redo Object(s) CTRL + Y COMMAND + Y 

Show Photo Information CTRL + SHIFT + I COMMAND + SHIFT + I 

All 

Increase the size of Object from – 
Top Left 

ALT + 7 ALT + 7 

Increase the size of Object from – 
Top Center 

ALT + 8 ALT + 8 

Increase the size of Object from – 
Top Right 

ALT + 9 ALT + 9 
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Increase the size of Object from – 
Center Left 

ALT + 4 ALT + 4 

Increase the size of Object from – 
Center 

ALT + 5 ALT + 5 

Increase the size of Object from – 
Center Right 

ALT + 6 ALT + 6 

Increase the size of Object from – 
Bottom Left 

ALT + 1 ALT + 1 

Increase the size of Object from – 
Bottom Center 

ALT + 2 ALT + 2 

Increase the size of Object from – 
Bottom Right 

ALT + 3 ALT + 3 

All 

Decrease the size of Object from 
– Top Left 

CTRL + ALT + 7 COMMAND + ALT + 7 

Decrease the size of Object from 
– Top Center 

CTRL + ALT + 8 COMMAND + ALT + 8 

Decrease the size of Object from 
– Top Right 

CTRL + ALT + 9 COMMAND + ALT + 9 

Decrease the size of Object from 
– Center Left 

CTRL + ALT + 4 COMMAND + ALT + 4 

Decrease the size of Object from 
– Center 

CTRL + ALT + 5 COMMAND + ALT + 5 

Decrease the size of Object from 
– Center Right 

CTRL + ALT + 6 COMMAND + ALT + 6 

Decrease the size of Object from 
– Bottom Left 

CTRL + ALT + 1 COMMAND + ALT + 1 

Decrease the size of Object from 
– Bottom Center 

CTRL + ALT + 2 COMMAND + ALT + 2 

Decrease the size of Object from 
– Bottom Right 

CTRL + ALT + 3 COMMAND + ALT + 3 

Page 
Flip Page composition 

Horizontally 
ALT + H ALT + H 

Flip Page composition Vertically ALT + V ALT + V 

View 

Fit to Screen CTRL + F12 COMMAND + F12 

Actual Size (1:1) CTRL + SHIFT + F12 COMMAND + SHIFT + F12 

Zoom In + + 

Zoom Out - - 

Screen Toggle Full Screen CTRL + SHIFT + F11 COMMAND + SHIFT + F11 
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4.0. Getting into the Job 

– Using the Software 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gift Xpress 

In previous section, we learnt about software functionality. Now in this section we will learn 
how to use this software to create Gifts. We will see various available categories and sizes. 

 

4.1. Predefined Categories & Sizes 
 

4.2. Create, Edit & Delete Category * 
 

  4.2.1. Creating a Category * 
  4.2.2. Editing a Category * 
  4.2.3. Deleting a Category * 
 

 4.3. Create, Edit & Delete Sizes * 
   

  4.3.1. Creating a Size * 
4.3.2. Editing a Size * 
4.3.3. Deleting a Size * 
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4.1. Predefined Categories & 

Sizes 
 
 
 
Gift Xpress is versatile software that lets you use its made-to-standard, predefined categories and sizes. 
The ready-to-use Gift types, which conform to industry standards, come in major variants. Each of these 
categories has multiple gift options and you can choose the size that suits the Gift you want to design.  
 

 
Predefined Categories and Sizes 

 
Gifts are categorized into following categories. 
 

 Mug Regular: Makes Customized and Personalized gifts with inbuilt products such as Coffee Mug, Color 
inside Mug, Animal Mug, Lovers Mug, Magical Mug, Small Cone Mug and Cone Mug. 
 

 Key Chain: Makes Customized and Personalized gifts with inbuilt products such as Small Oval Key chain, Big 
Oval key chain, Rectangle key chain, Heart key chain. 
 

 Pillow Cover: Makes Customized and Personalized gifts with inbuilt products such as Square Pillow cover, 
Heart Pillow cover and Rectangle Pillow Cover. 
 

 Mobile Covers: Makes Customized and Personalized gifts with inbuilt products such as I-Phone 4S, I-Phone 
5S, I-Phone 6, I-Pad Mini, I-Pad, Samsung S3, Samsung S4, Samsung S5 and Samsung Grand. 
 

 Clocks: Makes personalized clock design with inbuilt products like Six Photos Clock, Seven Photos Clock and 
Ten Photos Clock. 
 

 Collage Frames: Makes customized photo frames with various products such as Five Photos Frame and Ten 
Photos Frame. 
 

 Other Gifts: Apart from the categorized gifts, we have some other spare gift products such as Cap, Water 
Bottle, Puzzle, T Shirt, mousepad, mousepad circular, Laptop Sleeve 14 inch and Laptop Sleeve 17 inch. 
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4.2. Create, Edit & Delete 

Categories * 
 
 
Gift Xpress has a variety of standard predefined categories for Gifts (refer section Predefined Categories 
and Sizes). However, in case, the Gift category you have in mind is not among the standard categories, you 
could create your own category and save it for reuse, edit it or delete it as per your requirement. This 
section will let you know about creating, editing and deleting the categories in detail. 
 
 
 

4.2.1. Creating a Category * 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 
‘Select Category’ window - Predefined Categories 

 
 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 

‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Click on the ‘Edit’ icon. You will see Add, Edit and Delete options. 
 

 Select the ‘Add’ option to add a new category in the ‘Select Category’ window.  
 

 On the next ‘Create Category’ window, Fill in the fields corresponding to the, 

o ‘Name’: The name you want for the new Category. 

o ‘Ref. Image’: The image you want for the Category, clicking on the ‘Browse’ icon  to the right of this 
field lets you choose the reference image from the path in which you saved it.  

o ‘Description’: Give a description of the category you are creating.  
 

Available 
categories ‘Edit’ icon 
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‘Create Category’ window – Adding Category 

 

 Click on ‘Save’ icon  on the lower right-hand corner to save the category you created.  
 

 
The New category added 

 

 The new category is created and can be viewed along with the predefined categories. 
 
 
 
 
 
 
 
 

 
 
 
 
 

4.2.2. Editing a Category * 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Select the category you want to edit. Click on the ‘Edit’ icon. You will see Add, Edit and Delete options. 
 

Note: Features marked with * mark are available only for PRO version users. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By clicking 
on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. You could 
also click on ‘Home’ to go back to the home page. 
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‘Select Category’ window - Predefined Categories 

 
 Select the ‘Edit’ option to edit selected category in the ‘Select Category’ window.  

 

 
‘Edit Category’ window – Editing Category 

 
 On the next ‘Edit Category’ window, You can add the edits to the, 
 

o ‘Name’: Edit the name as per your choice. 

o ‘Ref. Image’: Change the image you want for the Category, clicking on the ‘Browse’ icon  to the right 
of this field lets you choose the reference image from the path in which you saved it.  

o ‘Description’: Change the description of the category as per your choice.  
 

 Click on ‘Save’ icon  on the lower right-hand corner to save the changes you made.  
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Note: Features marked with * mark are available only for PRO version users. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

Available 
categories ‘Edit’ icon 
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4.2.3. Deleting a Category * 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 
‘Select Category’ window - Predefined Categories 

 
 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 

‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Select the category you want to delete permanently. Click on the ‘Edit’ icon. You will see Add, Edit and 
Delete options. 
 

 Select the ‘Delete’ option to delete selected category in the ‘Select Category’ window.  
 

 A dialog box asking if you are sure, you want to delete category appears on the screen.  
 
 Clicking on ‘Yes’ deletes the category permanently; clicking on ‘No’ aborts the operation.  

 
 
 
 
 
  
 
 
 
 
 
 
 
  

Note: Features marked with * mark are available only for PRO version users. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ 
command. You could also click on ‘Home’ to go back to the home page. 
 

Available 
categories ‘Edit’ icon 
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4.3. Create, Edit & Delete Sizes * 
 
 
 
 
Apart from the categories, you can also create, edit and delete sizes in Gift Xpress. You get a freedom of 
designing Gift in your own size. You can define your own custom Gift parameters. This section will let you 
know about creating, editing and deleting the sizes in detail. 
 
 
 

4.3.1. Creating a Size * 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 
‘Select Category’ window  

 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
 

 Select the category in which you want to add new size. Click on the  icon. Add, Edit and Delete icons will 
get visible. 
 

 Select the ‘Add’ icon to add a new size in the selected category.  
 

 On the next window: ‘Create Gift’ window, Fill in the fields corresponding to the, 
 
o ‘Name’: add new name for the new Gift size.  

 

o ‘Ref. Image’: the image you want for your gift. Clicking on the icon  to the right of this field lets 
you choose the reference image from the path in which you saved it. 
 

o Define the Gift parameters under ‘Page’ tab. 

 Icon 
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Units 
Width, height and DPI 
Margins (Left/Right/Top/Bottom) 
 

o Checking the ‘Export all photos as separate images’ check box will allow you to export all the images 
separately. 

 

 
The ‘Create Gift’ window 

 
o Checking the ‘Use Special Designs’ check box will allow you to view the designs in design area. 

 
o Check the ‘Export only Print Area’ to export only design area. 

 

o Give mirror effect to the output from the  option. 
 
o Define product details from ‘Product’ tab. 

 
o Check the ‘Use Product Image’ checkbox to insert the overlay image of the product. 

 

o Define the reference image, clicking on the icon  to the right of this field lets you choose the 
reference image from the path in which you saved it.  

 
o Check the ‘Export Product Image’ checkbox to export the overlay image of the product. 

 
 Click on ‘Save’ icon on the lower right-hand corner to save the size you created. 
 
 The new Gift size is created and can be viewed along with the other Gift sizes. 
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New size is created 

 
 
 
 
 
 
 
 
 
 
 

4.3.2. Editing a Size * 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
 

 Select the size, which you want to edit. Click on the  icon. Add, Edit and Delete icons will get visible. 
 

 
‘Select Category’ window  

 
 Select the ‘Edit’ icon to edit selected size in the selected category.  
 

Note: Features marked with * mark are available only for PRO version users. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

 Icon 



 

 

www.dgflick.com Page 23 of 119 

 On the next window: ‘Edit Gift’ window, Edit in the fields corresponding to the, 
 
o ‘Name’: edit the name as per your choice. 
 

o ‘Ref. Image’: the image you want for your gift. Clicking on the icon  to the right of this field lets 
you choose the reference image from the path in which you saved it. 
 

o Edit the Gift parameters under ‘Page’ tab. 
Units 
Width, height and DPI 
Margins (Left/Right/Top/Bottom) 
 

o Checking the ‘Export all photos as separate images’ check box will allow you to export all the images 
separately. 
 

 
The ‘Edit Gift’ window 

 
o Checking the ‘Use Special Designs’ check box will allow you to view the designs in design area. 

 
o Check the ‘Export only Print Area’ to export only design area. 

 

o Give mirror effect to the output from the  option. 
 
o Define product details from ‘Product’ tab. 

 
o Check the ‘Use Product Image’ checkbox to insert the overlay image of the product. 

 

o Define the reference image, clicking on the icon  to the right of this field lets you choose the 
reference image from the path in which you saved it.  
 

o Check the ‘Export Product Image’ checkbox to export the overlay image of the product. 
 

 Click on ‘Save’ icon on the lower right-hand corner to save the changes you made. 
 

 
 
 
 

Note: Features marked with * mark are available only for PRO version users. 
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4.3.3. Deleting a Size * 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 
‘Select Category’ window 

 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
  

 Select the size, which you want to delete permanently. Click on the  icon. Add, Edit and Delete icons will 
get visible. 
 

 Select the ‘Delete’ icon to delete selected size in the selected category.  
 
 A dialog box asking if you are sure, you want to delete size appears on the screen. 
 
 Clicking on ‘Yes’ deletes the size permanently; clicking on ‘No’ aborts the operation. 

 
 
 
 
 
 
 
 
 
 
  

Note: Features marked with * mark are available only for PRO version users. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

 Icon 
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5.0. Exploring the World 

of Designing – Design 

Gifts 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

In previous section, we learnt about managing Gift categories and sizes. In this section, we will 
learn how to create Gifts. 
 

 

5.1. Automatic Gift Creation 
 

5.2. Advance Gift Creation  
 
5.3. Manage the Photos 
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5.1. Automatic Gift Creation 
 
 
 
 
 
Using Gift Xpress is a fast and user-friendly process, with an interactive interface, that gives you the 
flexibility of selecting category and size and the Gift is ready in a quick way. It makes the designing task 
simpler. 
 

 On the ‘Select Category’ window, select the Category and size you would like to use for the Gift.  
 

 
The ‘Select Category’ window 

 

 Click on ‘Next’ button  on the lower, right-hand corner to move on to generate the Gift. 
 
 
Design Gift 

 
 The Gift is now ready and can be viewed in the ‘Design Gift’ window. 

 

 
‘Design Gift’ window 

 
 You can use various tabs at the bottom option bar to design the gift. 
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Design 
 

 You can insert any ready design from the ‘Design’ tab. You will see various designs for the gift. The designs 
are categorized into various categories. 
 

 From the design bank, you can filter your search 
and get the designs as per your requirements by 

clicking on . The categories are Orientation, 
No. of Photos, Color, Theme, Style and the 
Default option.   
 

 Select the category of your choice and insert the desired design by double clicking on it. 
 

 
Design appeared on the page 

 
 
Photo 

 
 Click on the ‘Photo’ tab to access the photos for the gift. 

 

 
‘Design Gift’ window – ‘Photo’ tab 

 

 To get the additional controls for managing photos, click on the ‘More’ icon . (For details, refer section 
Manage the Photos) 
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The ‘Change Path’ window 

 

 You have the option of selecting the photos from the various available options . 
 

Hard disk  CD/DVD USB 
 

 You can make changes to the photos using the options listed at the bottom of the window. (for details refer 
Section Manage the photos) 
 

 Click on ‘Ok’ button  to go back to the ‘Design Gift’ window. 
 

 To use a photo, either double click on it or drag and drop it on the canvas. 
 

 Sort the photos by clicking on ‘Sort By’ button.  
 

 Filter the photos by their used status from ‘Filter’ option. 
 

 
Photo added in gift 

 
 
Zooming In/Out 
 

 While working on the Gift you can focus your attention on a specific area of the photo by zooming in or 
take a look at the ‘larger picture’ by zooming out. You can use a combination of these options to obtain the 
desired level of visibility on the page. 
 

 How to: Click on the photo you want to work on and then use the scroll wheel of the mouse to zoom in or 
zoom out as per your requirement. 
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Panning  
 

 Panning lets you view specific areas of the photo by moving the photo up or down and sideways in the 
canvas area. This gives access to the areas that would otherwise remain obscure given the size of the 
photo. 
 

 How to: Place the cursor over , which then changes to  or the ‘hand symbol’. Now use your mouse 
to take hold of the photo and move it around to get to the area you wish to work on. 
 
 
Swapping Photos  
 

 Many a times you need to swap photos on a page as you go along. However, the borders if applied to the 
photos are not swapped. 
 
How to: Select the photos you wish to swap by keeping the ctrl key pressed. When both the photos are 

selected, the ‘Swap’ icon appears . Click on the icon to swap the photos. 
 
 
Color correction 
 

 ‘Color Correction’ tab helps you to color correct photos instantly. The instant color correction feature helps 
you to color correct photos according to the background.  
 

 You can color correct multiple photos at a time. Select the photos you wish to color correct. 
 

 
 
 
 

‘Design Gift’ window - ‘Color Correction’ tab 
 

 From ‘Brightness, Contrast and Gamma’ sliders , you can adjust the brightness, contrast and gamma of 
the photos. 
 

 To adjust the red, green and blue value of the photos, use the ‘Red, Green and Blue’ sliders . 
 

 You get individual ‘Reset’ option in front of each slider. 
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 From ‘Reset all’ button , you can reset all the color corrections in single click. 
 
 
Border 
 

 Click on ‘Border’ tab on the ‘Design Gift’ window to select the border that you want for the photo. 
 

 You could browse and select a border of your choice from the path in which you have saved it. 
 

 
‘Design Gift’ tab – ‘Border’ tab 

 
 Double click on the border or drag and drop the border on the photo to apply. 

 
 You could change the color of the border to suit the photo by clicking on the ‘Ready Tone’ button. There are 

18 ready tones available for use. 
 

 Double click on the ready tone you want to apply on selected photos.  
 

 Remove the border with ‘Remove’ option. 
 

 You can transform these borders freely on the page.  
 
! Additional icons on the ‘Design Gift’ – ‘Border’ tab:  
 

o ‘Flip Vertical’ : To flip the border vertical. 

o ‘Flip Horizontal’ : To flip the border horizontally. 

o ‘Rotate CW90’ : To rotate the border 90 
degrees. 

o ‘Rotate CW180’ : To rotate the border 180 
degrees. 

o ‘Rotate CW270’ : To rotate the border 270 
degrees. 

 
 
Rotating Photos 
 

 Rotating photos in a Gift keeping the creative design in mind adds to the overall presentation of the page. 
Gift Xpress gives you the option of either rotating the photo within the frame or rotating the whole picture 
along with the frame. 
 

 To rotate the photo within the frame: Keep your cursor on the rotate icon that is seen when you select 
a photo. Once the ‘hand’ symbol appears, use the mouse to rotate it in the direction of your choice. 
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 To rotate the photo along with the frame: ‘Unlock’ the photo by clicking on . Now keep your cursor on 

 and use the mouse to rotate the photo with the frame when the ‘hand’ appears. 
 
 
Right Clicking 
 

 While working in Gift Xpress, you could use the right click button to get several options right then and 
there. 
 

 Right clicking outside photo: Right clicking outside photos lets you access the following options directly: 
 
o The ‘Effects’ option- Give effects like Colorize, Blur, Opacity, Feather, Shadow, Glow, Outline, Rotation 

and Blend. 
  

o The ‘Flip Page’ option to flip the page either vertically or horizontally. 
 

 Right clicking on the photo: Using right click after selecting a photo lets you access the following options 
directly: 
 
o Cut, copy, paste (in case an element has been copied) and delete. 

 
o The ‘Effects’ option- Give effects like Colorize, Blur, Opacity, Feather, Shadow, Glow, Outline, Rotation 

and Blend and copy, paste and clear effect.  
 

o Arrange objects- Send to Back, Send Backward, Bring to Front and Bring Forward. 
 

o Align to page- Top Left, Top Center and so on. 
 

o The ‘Flip Page’ option to flip the page either vertically or horizontally. 
 

o The ‘Find’ option to find the source of the object. 
 

 You can have a preview of the design by clicking on the ‘Preview’ icon. 
 

 Photo Quality Indicator: The quality of photos used in the Gift must be good to ensure clarity in the final 
product. Gift Xpress has an in-built ‘Quality Indicator’, which warns you whenever the photo quality goes 
below the required standards. 
  

 Your Gift design is ready in an easy way and now can be sent for exporting.  
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5.2. Advance Gift Creation 
 
 
 
 
Gift Xpress provides you some advance features of designing where you get a more personalization tools 
for Gift. In this section, we will use some advance features that are available in Gift Xpress. 
 
The Tool Bar 
 
The tool bar at the top of the screen has a variety of options that makes Gift Xpress user friendly and easy 
to work with. If any tools are unavailable in the window, you can make them visible from ‘Preferences’ tab. 
These options are explained below. 
 

Table The Tool Bar 

Icon Use 

<Lock/unlock objects> 

 
Can be used to lock or unlock the photos as per the requirement. 

<Arrange objects> 

 

The four options in this tool – Send to Back, Send Backward, Bring to Front, 
Bring Forward – help in moving objects forward and backward depending on 
the page layout. Click on the object and then choose the option required to 
move the photo accordingly. 

<Page based alignment> 

 

This option can be used to move the object around with respect to the page. 
Click on the object and then select the option on the bar to apply the changes. 

<Object based alignment> 

 

This option can be used to move the object around with respect to the other 
objects on the page. Click on the object and then select the option on the bar 
to apply the changes. 

<Equal spacing>  

 

Helps to equalize the horizontal and vertical spacing between objects. Select 
the objects for which you wish to equalize spacing. Click on the tool and select 
either ‘Vertical’ or ‘Horizontal’ as per your choice. 

<Equal size> 

 

Helps to equalize the size of two or more photos on a page. Select the photos 
of which you want to equal the size. Then click on this tool and select the 
parameter for equalizing: Width, Height and Size. 

<Group/Ungroup> 

 

Group and ungroup elements on the page. Grouping (select objects to be 
grouped and then click on the tool and select ‘Group’ option) ensures that the 
photos that are grouped move together as one unit with the spacing intact. 
To move an element of a group individually you need to ungroup the 
elements (click on the grouped photo and select ‘Ungroup’ option). 

<Rotate object> 

 

Rotates the object. To rotate the object as per your requirements, click on the 
tool and alter the x, y and z axis. You could also rotate it by 90 or 270 degrees 

and flip them vertically  or horizontally . You could also rotate the 
image manually by using number box and entering the value of your choice or 

using the slider . 
<Edit photo> 

 
Helps you to enhance the photos. 

<Undo> 

 
To reset the change you made on the page. 
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<Redo> 

 
To redo a change you made on the page. 

<Show/hide margins> 

 
Shows/hides the margins on the page. 

<Show/hide gridline>  

 
Shows/hides the gridlines on the page. 

<Zoom in> 

 
For zooming the page in. 

<Zoom out> 

 
For zooming the page out. 

<Fit to screen> 

 
Adjusts the page size such that the page fits the screen. 

<Actual Size> 

 
Shows the actual size of the page. 

<Full size> 

 
View page in full size. 

 
 On the ‘Select Category’ window, select the Category and size you would like to use for the Gift.  

 

 
The ‘Select Category’ window 

 

 Click on ‘Next’ button  on the lower, right-hand corner to move on to generate the Gift. 
 

 The Gift is now ready and can be viewed in the ‘Design Gift’ window. 
 

 
‘Design Gift’ window 
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 You can use various tabs at the bottom option bar to edit the Gift. 

 
 
Background 
 

 Let us start with the background. 
 

 Click on the ‘Background’ tab on the option bar to select the background for the Gift or to fill it with any 
solid color. 
 

 Besides the in-built backgrounds, you could access and select backgrounds that you have saved elsewhere 

by clicking on the ‘Browse’ button . The last 15 paths used can be viewed. 
 

 
 
 
 
 

‘Design Gift’ window - ‘Background’ tab 
 

 To use a background, double click on it or drag and drop it on the canvas from the option bar. 
 

 Uncheck the ‘Fit to size’ check box on the ‘Background’ tab to expand the background on the page. 
 

 To fill the canvas with one single solid color, click on ‘Color Picker’  and place it on the color you wish to 
use as background for the Gift. The whole page now gets a background of that color. 
 

 Click on the ‘Ready Tone’ option in the ‘Background’ tab to see the 18 ready tones of selected background. 
 

 To change the tone, double click on the chosen tone.  
 

‘Ready Tone’ and ‘Remove’ option 

‘Fit to size’ 
option 
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Ready tone applied 

 
 You can remove the background with the ‘Remove’ button. 

 
 You could also use a photo of your choice as the 

background for the Gift. To do this, click on the 
‘Photo’ tab to view the photos. Select the photo and 
click on ‘Set as background’. The photo now serves as 
a background to the page. 
 

  
Gift with photo as background 

 
 
Photo 

 
 Click on the ‘Photo’ tab to access the photos for the gift. 

 

 
‘Design Gift’ window – ‘Photo’ tab 

 

 Click on the ‘Browse’ button  and give the path of the photo folder. The photos in the selected folder 
will open in the ‘Photo’ tab. 
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 To get the additional controls for managing photos, click on the ‘More’ icon . (For details, refer section 
Manage the Photos) 

 

 
The ‘Change Path’ window 

 

 You have the option of selecting the photos from the various available options . 
 

Hard disk  CD/DVD USB 
 

 You can make changes to the photos using the options listed at the bottom of the page. (for details refer 
Section Manage the photos) 
 

 Click on ‘Ok’ button  to go back to the ‘Design Gift’ window. 
 

 To use a photo, either double click on it or drag and drop it on the canvas. 
 

 Sort the photos by clicking on ‘Sort By’ button.  
 

 Filter the photos by their used status from ‘Filter’ option. 
 

 To insert multiple photos at a time, keep the control key pressed and keep on selecting the photos you 
want to insert.  
 

 Use the ‘Add Photos’ button to insert all the selected photos at once. 
 

 
Photos added in gift 
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Mask 
 

 Go to the ‘Mask’ tab on the option bar to select the mask of your choice. 
 

 Select the photo to which you want to apply the mask and double click on the mask or drag and drop the 

mask on the photo to apply it. Browse from ‘Browse’ icon  and bring in your own masks. 
 

 
‘Design Gift’ window – ‘Mask’ tab – Mask applied on both the photos 

 
 You can transform these masks freely on the page.  

 
! Additional Icons on ‘Mask’ tab 

o  Masks can be flipped horizontally or vertically o  Masks can be rotated in 900, 1800 and 2700 
degrees in clockwise direction 

 
 
Effects 
 

 To apply effects to the photos; click on ‘Effects’ tab on the option bar.  
 

 There are different options under this category. They are: Colorize, Blur, Opacity, Feather, Shadow, Glow, 
Outline, Rotation and Blend . Apply the desired effect on the photo. 
 
o Colorize: Click on the photo to be modified and then click on the colorize preset to apply the effect to 

the photo. To manually make changes or customize, use the ‘Custom’ panel available at the right side 
of the tab and change the color, opacity and level using ‘Color Picker’ and sliders. Reset the effect with 

‘Reset’ option . 
 
o Blur: You could give a blurred appearance to some photos to make the page visually more appealing. 

Click on the photo you need to blur and then select the preset of your choice under this option. Use 
the ‘Custom’ panel available at the right side of the tab and increase or decrease the level or blurriness 
using the slider.  

 

o Opacity: Add opacity to the photos by selecting the presets available under this option. You could also 
manually choose the level of opacity from the ‘Custom’ panel available at the right side of the tab.  

 

o Feather: Apply the feather effect to the photos by clicking on the photo and then selecting the preset 
of your choice. Use the ‘Custom’ panel available at the right side of the tab to manually change the 
values of the feather using the slider.  
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o Shadow: To apply the shadow effect to the photos, click on ‘Shadow’ and then choose from the 
available presets. Use the ‘Custom’ panel available at the right side of the tab to apply the shadow 
settings manually.  

 
o Glow: Apply the required presets under the ‘Glow’ option by clicking on the photo and then clicking on 

the preset. Use the ‘Custom’ panel available at the right side of the tab for changing your blur, color 
and opacity values.  

 
o Outline: Select the photo and click on the preset of your choice to apply the outline. To customize the 

outline, Use the ‘Custom’ panel available at the right side of the tab and create the outline of your 
choice by filling in the values in these fields.  
 

 
‘Design Gift’ window – Outline effect applied      Available Effects 

 
o Rotation: The photos on the Gift page can be rotated using the predefined presets under the ‘Rotation’ 

option. Use the ‘Custom’ panel available at the right side of the tab to flip the photo horizontally and 

vertically by using  and , respectively.  
 
o Blend: There are 12 blending modes that help you achieve the desired effect for the photo. Click on the 

photo and then select the blend option of your choice to apply. 
 
 
Clipart 
 

 Click on the ‘Clipart’ tab on the option bar to preview available clip-arts.  
 

 Double click on the clip-art of your choice or drag and drop it onto the canvas to use it on the page. You 
can also replace clipart. To do so, select the existing clipart on the page and then double click on the clipart 
you want to insert. 
 

 You could even use your own clip-arts by accessing them using ‘Browse’ option . 
 

 Click on ‘Ready Tone’ button  to access the ready tones for the clip-arts. There are 18 ready tones 
available for each clipart and you could use the color of your choice depending on your page by double 
clicking on the ready tone.  

 

‘Custom’ 
panel 
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‘Design Gift’ window – ‘Clipart’ tab – clipart added 

 

 You may reset the ready tone with the help of ‘Reset’ icon . 
 

 In the same way, you can add or change the cliparts, as you desire. 
 

 You may apply shadow effect to the clipart if you want from the 'Effects' tab. 
 

 
‘Design Gift’ window – Shadow effect given to the clipart 

 
 

Title 
 

 You can insert titles from the ‘Title’ tab. 
 

 
 
 
 

'Title' tab 

White field 
to insert title 

Style Panel  Shadow Panel Outline Panel 
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 Click on the ‘Title’ tab to add or amend a title for the photo. 

 
 You can do several creative things with title. Let us have a look. 

 
 First, use the white space to insert the title on the page. 

 
 There are three panels in the window. 

 
o Style Panel: This panel allows you to set the style of the title.  
 
 
 
 
 

 
Style Panel 

 
o Set the font type and size from Style Panel.  
 
o You can also apply the effects like bold, italic and underline from the Style Panel. The alignment of the 

title can also be managed. 
 
o The title can be filled with solid color or any texture.  
 
o Use the color picker or color palette to select the color for the title. 
 
o If you want to fill title with any texture, 'Title' tab helps you with the texture tools. 

 

o Click on the 'Texture' icon  . You will see 
‘Browse’ option.  

 
 

o Once you click on the option, you will be redirected to a window where you can select the image you 
want to insert as texture. 
 

o DgFlick provides you 50 ready textures.  
 
o You may browse and use your own textures as well. 

 
o Select the texture image and click on ‘Open’ option. 

 

Select font type and 

size for the title 

Title fill options 

Effects and 

alignment of title Opacity of the title 

fill 
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Ready textures by DgFlick 

 
o The texture will appear in the title. You may set the texture in the ‘Tile’ and ‘Stretch’ style. These 

options get visible after you click on 'Texture' icon. 
 
o You can manage the opacity of the title fill from the opacity slider. You can also insert the values 

manually. 
 

o Shadow Panel: You can give shadow effect to the title from this panel. There are various tools in the 
panel to customize the shadow effect. 

 
 
 
 
 

 
Shadow Panel 

 
o Use the color picker or color palette to select the color for the shadow. 

 
o Axis of the shadow can be manipulated. You have got X and Y sliders to manage axis. You can either use 

the sliders or enter the values manually. 
 

o The blur and opacity level of the shadow can be manipulated from the respective sliders. 
 

o Reset the shadow with ‘Reset’ icon . 
 
o Outline Panel: Title can be given an outline with desired effect. 
 
 
 
 
 
 
 

Color of the 
shadow 

Reset shadow 

Blur and opacity 
level of the 
shadow 

Axis of the 
shadow 
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Outline Panel 

 
o The color of the outline can be selected via color picker or color palette. 

 
o Width and opacity of the outline is customizable and can be managed with either sliders or value box. 
 

 
Ready presets of the title 

 

o The outline can be reset with the help of ‘Reset’ icon  
 
 
Shape 
 

 Click on ‘Shape’ tab on the option bar to select a shape you would like to add to decorate the page. 
 
 
 
 
 

 
Shape customizing options 

 
 

 Double click on the shape or drag and drop onto the canvas. 
 

 You can align and resize the shape or rotate it using icon on the shape. 
 

Manage the width of the outline from the slider or define width manually 

Fill the shape with color 
picker, color palette or 
texture and manage 
the opacity of the color 
fill with slider or define 
the numbers manually 
 

Manage the color of 
the outline from the 
color palette and color 
picker and opacity of 
outline color from 
slider or define 
number manually 
 

Color of the outline 

Reset outline 

Width and opacity 
of the outline 

Ready presets 
for title 
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 To customize the shape according to your taste, use the ‘Custom’ panel available at the right side of the tab. 
 

 
‘Design Gift’ window – ‘Shape’ tab 

  
 You can have a preview of the design by clicking on the ‘Preview’ icon. 

 
 In this way, you can create your Gift and send for exporting. 
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5.3. Manage the Photos 
 
 
 
 
In this section, we will learn how to manage the photos. 
 

 Click on the ‘Photo’ tab to access the photos for the gift. 
 

 
‘Design Gift’ window – ‘Photo’ tab 

 

 To get the additional controls for managing photos, click on the ‘More’ icon . 
 

 You will be redirected to the ‘Change Path’ window where you can manage the photos, edit them, give 
them desired effect, resize them or rename them. 
 

 On the ‘Change Path’ window, you have the option of selecting the photos from the  
 

Hard disk  CD/DVD  USB  
 
 When you select hard disk option, the default drives available in your computer are shown. In addition, 

some quick access locations like Desktop, My Documents and My Pictures are also listed. 
 

 
'Change Path' window – showing quick access locations 
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 Select any of the media where the photos have been saved. 
 
 
 

 
‘Change Path’ window 

 
 

 Go forward or backward from here . 
 

 View your folders in list or icon style from here . 
 

 This button  on the top right corner of the window to get the better view of the photo thumbnails. 
 

 The top option bar helps you to view the photos in different ways 

o  Thumbnail style.  

o  Filmstrip view. 

o Navigate the photos from  and . 
 

o  To get a full view of the photo.  

o  Get the photos list wise. 

o  Starts the slide show 

 Select the photos to be rotated. Here you can rotate the multiple photos. 
 

 Select ‘Rotate Clockwise’ or ‘Rotate Counterclockwise’ icons  to rotate the photos. 
 

 ‘Edit Photo’ button at the lower option bar helps you to edit multiple photos * at a time. 
 

 On the ‘Edit Photo’ window, access color correction options like ‘BCG’ is to adjust the brightness, 
contrast and gamma; ‘RGB’ is to adjust the color tones, ‘Level’ is to adjust the input and output levels of the 
photo; and ‘Curve’ is to adjust the RGB color. 
 

 If you do not wish to apply the changes on the current photo, click on ‘Skip This Image’ . 
 

 To apply changes to all the selected photos, click on ‘Apply settings to all images’ . 
 

 Click on ‘Reset all’ button to reset all the changes done. 
 



 

 

www.dgflick.com Page 46 of 119 

 
‘Edit Photo’ window 

 
 

 Click on ‘Save’  to save all the changes made. 
 
 Clicking on Save will create a folder for original image and will save the changes made on the copy of the 

image, without affecting the original image. 
 
 
 
 

 Select ‘Resize’ option  to change the size of the photos.  
 
 A ‘Resize’ window will open on the screen. 

 
 

 
‘Resize’ window 

 

 Check the checkbox  of the images to be resized. 
 

 If you do not want to resize any selected image, uncheck the checkbox. 
 

 Select the desired percentage from ‘Percentage’  tab if you want to resize the images percentage wise. 
 

 From the ‘Original’  and ‘New’  tab, you can see the changes applied. The ‘Quality’ tab indicates 
the quality of the images. The quality of images used here must be good to ensure clarity in the final 
product.  
 

Note: Features marked with * marks are only for PRO version users. 
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 Gift Xpress has an in-built ‘Quality Indicator’, which warns you whenever the image quality goes below the 
required printing standards. 
 

 Go to ‘Size’  tab if you want to resize the images size wise. 
 

 In the drop down menu, you will see available sizes. Select any size in which you want to resize images.  
 

 If you want to resize in any new size, click on ‘Edit’ option. A window will appear. 
 

 Here an Image size has been added to make you familiar with the process. 
 

 
Adding size 

 
 
 

 To edit any of the available sizes, click on the desired size. The selected size will appear in the window. 
 

 
Editing available size 

 
 Edit the desired parameters and save the changes with ‘Save’ button. 

 
 You can add new size by clicking on ‘Add’ option located below available size list. 

 

 
Adding new size 

Available 
sizes 

‘Add’ option 

Selected size 
opened for 
editing 

‘Save’ option to 
save the size 

Name of the size 

Units and DPI 

Width and height 
new size 
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 Define the name for the new size in the ‘Name’ textbox. 

 
 Define the units and DPI for the new size from ‘Units’ and ‘DPI’ option. 

 
 You need to define the width and height of the new size in the ‘Width’ and ‘Height’ textbox. 

 
 Save the size with ‘Save’ button. Once you save the size, it will be added to the size list. 

 

 
New size saved 

 
 In this way, you can add new sizes. Add more sizes by clicking on ‘Add’ option. 

 
 Once you finish adding sizes, close the window. 

 

 
‘Resize’ window 

 
 From the drop down menu, select the size for resizing. 

 
 If you want to maintain aspect ratio while resizing, check the ‘Maintain Aspect Ratio’ checkbox. 

 

 After resizing the images click on ‘Save’  to overwrite the changes over the existing images.  
 

 Clicking on ‘Save as’ will save the changes done on the images with a different name. 
 

 Select the ‘Rename’ option  to rename the photos. 
 

 Manually change the photo name format from ‘Format’ option . 
 

 From ‘Starts From’ option, you can change the count of the photos. 
 

New size added 
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‘Rename’ window 

 
 

 Click on ‘Save’  to save the changes made. 
 

 ‘Selected Photos’ shows number of photos selected.  
 

 Here it indicates the position of highlighted photo. 
 

 Sort the photos in various ways from ‘Sort By’ button . 
 

 
 
 
 

‘Change Path’ window 
 

 Select individual, multiple or all photos or deselect selected photos with this ‘Select’ button .  
 

 Send the edited photos to any hard disk folder from ‘Send to’ option .  
 

 After selecting the photos and setting its arrangements click on  button to go to ‘Design Gift’ 
window, where you can view the selected photos ready with the selected parameters.  
 
 
 
 
 
  

Note: Features marked with * marks are only for PRO version users. 
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6.0. Building the 

Framework – Page 

Composition 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

In previous section, we learnt how to create Gift. In this section, we will learn how to align 
and decorate Gift. 

 
 

6.1. Basic Page Composition 
 

6.2. Advanced Page Composition 
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6.1. Basic Page Composition 
 
 
 
 
 
While you are designing the Gift, you need flexibility in operations to help you manipulate the photos to 
achieve the desired layout. Gift Xpress gives you this flexibility. This section deals with the additional 
features in the software that helps you in page composition. 
 
 
Used Photo Indicator 
 
While designing gift, you may be dealing with a large number of photos and managing them might turn out 
to be a cumbersome task. Gift Xpress helps you sort the photos and manage them better by indicating the 
photos that have been used and the number of times they have been used in the Gift. This helps you plan 
the Gift with the remaining photos and avoid using the same photos multiple times without being aware 
that you are doing so. 
 
Blue tab on the photo: This indicates the photos 
used in Gift. 

 

   
 
Number on the tab: This indicates the number of 
times the photo has been used in the Gift. 
 

   
 
Besides these options, photos can be sorted as ‘used’ and ‘unused’ by selecting the ‘Used’ button on the 
‘Sort By’ button. 
 
 
Find Photo/Decor  
 
After you are done with a gift designing, if you need to return to it re-edit later on, you can find the source 
photographs, borders and mask by simply right clicking on the photo on the Gift.  
Moreover, all the photos appearing on a Gift can be identified by the blue tab on them, as described 
earlier. 
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Use Photo as Background  
 
Gift Xpress provides you many backgrounds with 
its ready tone for the photos. Even you can add 
your own backgrounds from your hard disk. 
However, in some instances, to personalize the 
Gift, you might wish to use a photo as a 
background. This can be done in an instant way 
using the software.  
Just select the photo you want to use as 
background and choose the ‘Set as Background’ 
option under the ‘Photos’ tab on the option bar. 
The photo is now set as a background. 

  
Setting a photo as background for the Gift 

 
 
Swap Photos  
 
While working on a Gift, you might want to swap photos to achieve the desired effect on the Gift. Gift 
Xpress lets you do this by just a single click. Just select the photos to be swapped using the Ctrl key. Then 
click on ‘Swap’ icon to swap the photos. This is particularly useful to fit a portrait photo into a portrait 
frame and vice versa.  
 

  

 

(a) (b) (c) 

Swapping photos (a) Original photos, (b) Swapped Photos, (c) Swap Icon 
 
 
Lock and Unlock Photos 
 
Gift Xpress generally ‘locks’ photo on the ‘Design Gift’ window to ensure precise designing. This ensures 

that changes do not happen on the photos by mistake while one is working on the Gift. Clicking on the  

‘lock’ icon unlocks  it and now you can move it or resize it as per your wish. 
 
 
Resize Photo  
 
Within border: In the ‘locked’ condition, a photo can be enlarged within its frame, by zooming it and 
adjusting it in the frame. It can even be panned within the frame. 
With border: Once the photo is ‘unlocked’ by clicking on the icon, the photo can be resized according to 
your size requirements by moving the nodes.  
Ensure that the photo stays within ‘printable’ limits while increasing the size of the photo. Refer the ‘Photo 
Quality Indicator’. 
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Rotation of Photo 
 
Within border: A photo can be rotated within its frame when it is in the ‘locked’ state. However, if a border 
or a mask has been applied to it, it stays in its position while the photo alone rotates within it. 
With border: A photo can be rotated along with its border or its mask as a single unit when the photo is in 
an ‘unlocked’ state. The photo can now be rotated in all three axis x, y and z to give it a 3D effect. 
 
 
Copy, Paste and Clear Effects  
 
Gift Xpress allows you to cut, copy and paste 
photos and effects on the photos in the Gift. 
Right click on the element you want to copy and 
select the ‘Copy’ option on the drop list. Now 
paste it on to the location of your choice by right 
clicking on it and choosing the ‘Paste’ option.  

  
 
 
Flip Decor 
 
Decors like border and mask can be flipped 
horizontally and vertically, with the help of 'Flip' 
option provided at the bottom in the respective 
tabs. 

 

 

 
 
Flip Page 
 

 Gift Xpress gives you the option of flipping a page both horizontally and vertically as per your 
requirements.  
 

 Horizontal flip: Right click on the page and select the ‘Flip page’ option on the drop list. Select ‘Horizontal’ 
to flip the page horizontally. 
 

 Vertical flip: Right click on the page and select the ‘Flip page’ option on the drop list. Select ‘Vertical’ to flip 
the page vertically. 
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6.2. Advance Page Composition 
 
 
 
 
Following are the options available with Gift Xpress for advanced page composition. 
 
 
Grid and Guideline 
 
Gift Xpress gives you the option of using grids and other guidelines such as ruler, margins on the Gift; you 
are designing to help you align the Gift better and design with ease.  
 

Grids: On the top, right-hand corner of the top option bar, click on  to activate the gridlines on the Gift 
you are working on. The grids on the page allow you to align the photos and other elements on the page 
accurately. 
Click on the same icon again to deactivate the grids on the page. 
 
Rulers: On the ‘Design Gift’ window, you can view the ruler at the top and on the left of the page. Double 
click on the ruler to activate it and then drag and drop the green line that appears on to the page at the 
desired location to align an element against it. You could work with multiple rulers simultaneously. 
Select and delete the rulers to remove them from the page. 

Margins: On the top, right-hand corner of the page, click on  to activate the margins on the page.  
Click on the icon again to deactivate the margins as per your requirement. 
 
 
Arrange objects  
 
Gift Xpress gives you the option of changing the 
position of an object on the Gift i.e. send it 
backward or forward or to the back or front. 
Select the photo you wish to move backward or 

forward and click on  to access the options 
under this function. 

 

 
Alternatively, use the right click button and on the drop list click on ‘Arrange’ to access the sub-options. 
Select the object and click on ‘Send to back’ or ‘Bring to front’ to move the element to the last or the first 
position, respectively. Select ‘Send backward’ or ‘Bring forward’ to move the object either one-step 

backward or one-step forward. You can undo the changes by clicking on . 
 
 
Object-Based Alignment 
 
This option allows you to align photos with respect to other photos or elements on the Gift. There are 
multiple options for this sort of alignment. Select photos or other elements you wish to align using the Ctrl 

key. Then click on  to select the alignment option you wish to apply to the photos from the drop list.  
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Alternatively, use the right click button and on 
the drop list click on the ‘Align to Object’ to 
access the sub-options. You can undo the 

changes by clicking on . 

 
 
 
Page-Based Alignment 
 
This option allows you to align photos and other 
elements on the page with respect to the page. 
There are multiple options for this sort of 
alignment. Select photos or other elements you 
wish to align using the Ctrl key. Then click on 

 to select the alignment option you wish to 
apply to the photos from the drop list. 
Alternatively, use the right click button and on 
the drop list click on ‘Align to Page’ to access the 
sub-options. You can undo the changes by 

clicking on . 
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7.0. Nuts & Bolts – 

Designs & Decors 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

This section deals with various available features of design and guides you on how to get 
more, import as well as Save and Build designs. 

 
 

7.1. Software Designs & Decors 
 
7.2. Customize your Design 
 
 7.2.1. Get More & Import 
 7.2.2. Save & Build * 
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7.1. Software Designs & Decors 
 
 
 
 
Gift Xpress has varieties of inbuilt designs and decor options, which offer a wide range of choices in 
designing Gifts. The features are listed here: 
 

 Gift Xpress has 300 ready-to-use inbuilt designs, which can be accessed by clicking on the ‘Design’ tab on 
the option bar.  

 
 Gift Xpress also has a huge collection of decor options for Gift designing. These include a variety of 

backgrounds, cliparts, frames and masks that help you to present the Gift in a more artistic and eye-
catching manner.  

 
 Besides the inbuilt decor options Gift Xpress also allows you to use your own backgrounds, borders, cliparts 

and masks. Any PNG and JPG file can be used as a clipart or as backgrounds and masks or borders can be 
designed or used directly on the Gift.  

 
 Backgrounds, borders and clipart’s are made available by a single click of the mouse. Besides, 18 ready-to-

use color tones are available for each of these elements and you can change the color of the elements to 
match the Gift color. This option is available even for your own decors.  

 
 
 

 
 DgFlick releases new design volumes at a regular interval to make Gift Xpress more and more versatile for 

the user. These designs can be downloaded or they can be bought in the form of CDs/DVDs.  
 
 The versatility of Gift Xpress enables you to create and save * your own designs for future use. Existing 

designs can be modified and saved as new designs or new designs can be created from scratch using your 
own or DgFlick’s decor elements. These can then be saved as designs for later use.  

 
 
 
 
 
  

Note: Features marked with * marks are only for PRO version users. 
 

! You could download utility from www.dgflick.com or buy relevant CDs/ DVDs.  
 

http://www.dgflick.com/
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7.2. Customize your Design 
 
 
 
 
This section explains how designs can be imported, saved or build in Gift Xpress. 
 
The versatility of Gift Xpress lies in the fact that it 
gives you a wide range of ready-to-use designs to 
choose from besides letting you create or modify 
designs according to your choice. Moreover, designs 
can be imported from other locations and built. 

 

 

! Save and Build options are available in the PRO version. 
 
 

 

7.2.1. Get more & Import 
 
 

Get More 
 

 DgFlick adds new design collection on the website on regular basis. You can add these designs to your 
software. 
 

 On ‘Design Gift’ window, Click on ‘Galleria’. Click on ‘Get More’ Button to access more designs from the 
DgFlick website.  
 

 You are now routed to www.dgflick.com from where you can download the designs of your choice and 
proceed to creating the Gift. 
 
 

Import 
 

 Gift Xpress software provides you the facility to use your own created or downloaded designs in design 
creation. 
 

 For that, you need to import your designs into the software. 
 

 On ‘Design Gift’ window, Click on ‘Galleria’ in the ‘Design’ tab. Click on ‘Import’ Button to Import designs.  
 

 Access the folder containing your designs by clicking on the ‘Browse’ button and selecting the location.  
 

 The 15 paths accessed immediately before this instance are saved in the path list box and can be accessed 
by clicking on the path. 
 

 Now select the designs from the location and click ‘OK’ to import them to the ‘Design’ tab. Now you can use 
the same in designing. 

  

http://www.dgflick.com/
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The ‘Import’ window 

 
 
 

7.2.2. Save & Build * 
 
 

 Gift Xpress gives you the option of building designs of your own. 
 

 To start the building process, first you need to save the design that you want to build.  
 
 Create the design and click on ‘Save’ in the ‘Design’ tab to save the design.  

 
 In the textbox that appears, enter the design 

information pertaining to the parameters (except the 
parameter according to which the design has been 
filtered).  
 

 These include No. of Photos, Orientation, Color, 
Theme, Style and Custom. Depending on the number 
of photos used in the design, here the number of 
photos is detected automatically. You can also enter a 
name for your design in the ‘Template Name’ box. 

  
Design information while saving your design 

 
 Click on ‘Ok’ to proceed and on ‘Cancel’ to quit the process. 

 
 To proceed with the building of your designs, click on ‘Build’ in ‘Galleria’ menu.  

 

 
Building your design – 1 
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 On the ‘Build’ window, select the designs and then click on ‘Build’ option. 
 
 In the text box that appears in next window, 

specify the name of the folder  in which you 

wish to save it and the path where you want to 
place it.  

Building your design - 2 
 

 If the path is not specified, the built volume is saved in the following path by default: My Documents\My 
Galleria\ Gift Xpress.  
  

 Check the box besides the ‘I agree to the terms and conditions’ and proceed by clicking on ‘Build’ .  
 
 
 
 

 A dialog box will appear which will inform you about successful buildup of designs. Click on the ‘OK’ button 
to continue building, else click on ‘Open’ to access the created design. 

 
 
 
 

 
 
 
  

! If you do not agree to the terms and conditions, close the textbox and quit the building process. 

 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. 
Note: Some features are available only for the Gift Xpress PRO version. 
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8.0. Fine Tuning – Photo 

Editing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

Gift Xpress has Basic Filters that helps in the editing of photos to be used in Gift. This filter 
includes several options that help you modify the photos to suit your requirements and they 
add value to the Gifts without much effort. This section deals with the photo editing features 
in Gift Xpress. 
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Features such as BCG correction, RGB color modification, Curve, Level, Crop and Rotation will be explained 

in detail in this section. You could view these options on the option bar. This section deals with the 
filters one by one. 
 
 
 

    
     ‘Edit Photo’ window     Basic Filters 
 
  

BCG (Brightness, Contrast and Gamma) Color Correction 
 

 To adjust the brightness, contrast and gamma of the photo, click on the ‘BCG’ button on the ‘Edit Photo’ 
window.  
 

 Move the sliders for the three parameters 
forward and backward to achieve the desired 
effect. 
 

 Alternatively, you could enter the values for the 
parameters in the value boxes above the 
respective sliders.   

The ‘BCG’ option 
 

 Clicking on the ‘Auto Contrast’ button  at the top will adjust the contrasts automatically  
 

 The changes can be reset by clicking on ‘Reset’  
 
 

RGB (Red, Green and Blue) Color Correction 
 

 To adjust the color tones of the photos, you could use the ‘RGB’ color correction option. 
 

 Modify the color tone by altering the degree of ‘Red’, ‘Green’ and ‘Blue’ on the color sliders. 
 

 Alternatively, you could enter the values manually in the value boxes above the respective sliders. 
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 Clicking on the ‘Auto Color’ button at the top will 
adjust the color automatically. 
 

 The changes can be reset by clicking on ‘Reset’ . 

 
The ‘RGB’ option 

 

 
Curve 
 

 Color intensities can be adjusted by clicking on 
‘Curve’ button on the option bar of the ‘Edit 
Photo’ window. 
 

 Select the color to be adjusted (RGB i.e. red, 
green or blue) from the drop list under the 

‘Channel’ button . 
 

 Adjust the intensity by clicking on the curve and 
moving it as per your requirement. 

 
The ‘Curve’ option 

 
 

Level 
 

 To adjust the input and output levels of the 
photo, click on ‘Level’ button on the option bar of 
the ‘Edit Photo’ window. 
 

 Select the color for which the input and output 
levels need to be modified (RGB i.e. red, green or 
blue) from the drop list under the ‘Channel’ 

button . 
 

 Modify the ‘Input’ and ‘Output’ level values in 
the value boxes as required. 

 
The ‘Level’ option 

 
 

Blur 
 

 To give the photo a blurred effect; click on ‘Blur’ button on the option bar of the ‘Edit Photo’ window. 
 

 Adjust the blur level from slider  forward and backward to achieve the desired degree of blurring. 
 

 The changes can be reset by clicking on ‘Reset’

. 
 

The ‘Blur’ option 
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Colorize 
 

 To give a color-film effect to the photo, click on ‘Colorize’ option on the option bar under ‘Basic Filters’. 
 

 Select the color from ‘Color Picker’ or ‘Color Palette’

. 
 

 Adjust the opacity from slider and level by 
inserting the value in the value box. 
 

 The changes can be reset by clicking on ‘Reset’ . 

 
The ‘Colorize’ option 

 
 

Feather 
 

 Click on ‘Feather’ option to give feather effect to the photo.  
 

 Adjust the feather effect by moving the slider  
forward and backward or by inserting the value 
in the value box.  

The ‘Feather’ option 
 

 It will help you to soften the hard edges of 
photograph. 
 

 The changes can be reset by clicking on ‘Reset’

. 
 

 
‘Feather’ effect applied to the photo 

 
 

Opacity 
 

 Click on ‘Opacity’ option to give opacity effect to 
the photo.  

  
The ‘Opacity’ option 

 

 Adjust the opacity by moving the slider forward and backward or by inserting the value in the value box.  
 

 The changes can be reset by clicking on ‘Reset’ . 
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Crop 
 

 To crop the photo to the desired dimensions and 
orientation, click on ‘Crop’ button on the ‘Edit 
Photo’ window. 
 

 Change the aspect ratio by clicking on the ‘Aspect 

Ratio’ box and select the required value.  
 

The ‘Crop’ option 
 

 Select the orientation you desire by selecting either ‘Landscape’ or ‘Portrait’ . 
 

 You can enter the values for the width and height after selecting the unit you want to work with.  
 

 Uncheck the ‘Maintain Aspect Ratio’ checkbox option if you would like to proceed with free hand 
cropping of the photo. 

 

  
(a) (b) 

Cropping: (a) Portrait; (b) Landscape 
 
 
Rotate  
 

 Select the ‘Rotate’ option on the option bar and then rotate the photo to the desired angle using the slider

. 
 

 The changes can be reset by clicking on ‘Reset’

. 
 

 Uncheck the ‘Show Grid’ box to remove the grid 
lines. 
  

The ‘Rotate’ option 
 

 You also have the option of using grid lines on the photo to help align it better while rotating. You could 

activate the grid lines by checking the ‘Show Grid’ checkbox .  
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Other Icons on Edit Photo window 
 
Apart from the options that are available under Basic filters, there are few other ‘aids’ in the Gift Xpress 
that help you as you proceed with designing the Gift. These are discussed below. 
 
 
Correction Tool in ‘Edit Photo’ window 
 

The correction tool appears with all options and can be used to ‘correct’ any error that might happen 
while using the filters or add to the effects already created. The brush size and feather tool can be altered 
by using the respective slider or by entering the value of your choice in the value box.  
 
 
 
 
 
 
Original and Before and After Images 
 
Original Image: In the course of working on the photos, you might decide to retain an original image or 
make a fresh set of changes. In such cases, you could load the original image once again by clicking on 

‘Load Original’. Once the ‘Load Original’ icon is clicked, the software asks for confirmation by displaying 
a dialog box. This dialog box warns that all changes made on the photo so far will be lost. You could click on 
‘Yes’ to proceed. Clicking on ‘No’ will take you back to the photo with changes.  
 
Before and After Images: After making a change, you could view how the photo looked just before the 
change was made by clicking on ‘Before’ and how the photo looks after the change by clicking on ‘After’. 
This aids in better decision-making. 
 
 
Saving the Changes 
 

There are two ‘Save’ icons on the lower right-hand corner of the ‘Edit Photo’ window.  
 

‘Save’ : Clicking on this icon causes the old file to be rewritten and the new copy now exists for your 
reference. 

 ‘Save as’ : Clicking on this icon will allow you to save a copy of your work. A dialog box allowing you to 
name the copy appears and clicking on ‘Ok’ after entering the name creates a new file of your work. 
 
  

! Remember to keep the Ctrl key pressed to activate the correction mode and to keep the Shift key pressed to undo 
the change.  
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9.0. Job’s Done – Saving 

& Exporting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

Gift Xpress allows you to save the file for future use and export it as required. These features 
add to the versatility of the software and simplify working on it to a great extent. This section 
deals with the saving and exporting files once the Gift is created. 

 

9.1. Saving the Project 
 

9.2. Exporting in JPG Format 
 
9.3. Exporting in PNG Format 
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9.1. Saving the Project 
 
 
 
 

 After the project is done, the next step is saving the project by clicking on ‘Save’ option. 
 

 
Saving Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 Save the Gift project with 'Save' option. 

 
 The default path for saving the project is 

displayed in the textbox as ‘My Documents \My 
Gifts’. You could either save the project in this 
path or provide the path of your choice to save 
the project.  
 

 Click on ‘Ok’ to save the project or on ‘Cancel’ to abort the process.  
 
 
  

'Save' 
option  
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9.2. Exporting in JPG Format 
 
 
 
 

 After the project is saved, the next step is exporting the project by clicking on ‘Save’ option. 
 

 
Exporting Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 To export the project in JPG format, select the ‘JPG’ option. 

 
 A window will appear. Assign a folder name for 

saving the JPG files. 
 

 The default path for saving the JPG file is ‘My 
Documents\My Exported Gifts’. However, you could 
change the path and save it in any location of your 
choice. 

 

 

 
 To access advance options for saving JPG, click on the ‘More’ option. Additional options will get visible. 

 
 Set the color profile by clicking on ‘Browse’ button. 

 
 You could optimize the quality or the file size by 

checking ‘Optimize Quality’ or ‘Optimize File Size’, 
as per your requirement.  
 

 To export the output as a mirror image, check the 
‘Mirror’ image. 

 
 

 Click on ‘Ok’ to proceed with the exporting or on ‘Cancel’ to abort the process. 
 

 Once the project has been exported, you get the confirmation in a dialog box. 
  

'Save' 
option  
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9.3. Exporting in PNG Format 
 
 
 
 

 After the project is saved, the next step is exporting the project by clicking on ‘Save’ option. 
 

 
Exporting Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 To export the project in printable PNG format, select the ‘PNG’ option. 

 
 A window will appear. 

 
 Assign a folder name for saving the PNG files. 

 
 

 The default path for saving the PNG file appears in the textbox. The path is ‘My Documents\My Exported 
Gifts’. However, you could change the path and save it in any location of your choice. 
 

 Click on ‘Ok’ to proceed with the exporting or on ‘Cancel’ to abort the process. 
 

 Once the project has been exported, you get the confirmation in a dialog box. 
 
 
 
  

'Save' 
option  
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10.0. How to Create 

Multi Photo Gift? * 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

In this section, you will learn how to create Multi Photo Gifts in Gift Xpress. 

 

10.1. Create Frame & Mask for Multi Photo Gift  
 

10.1.1. Creating Frame 
10.1.2. Creating Mask 
10.1.3. Save the Masks and Frames in the Application Folder 

 

10.2. Create, Edit & Delete Category for Multi Photo Gift 
 

10.2.1. Creating a Category 
10.2.2. Editing a Category 
10.2.3. Deleting a Category 

 

10.3. Create, Edit & Delete Size for Multi Photo Gift 
 

10.3.1. Creating a Size 
10.3.2. Editing a Size 
10.3.3. Deleting a Size 

 

10.4. Creating your Gift in Multi Photo Gift 
 
10.5. Save & Build Template 

 

10.5.1. Save Template 
10.5.2. Build Template 
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10.6. Get More & Import Template 
 

10.6.1. Get More Template 
10.6.2. Import Template 

 

10.7. Saving & Exporting Multi Photo Gift 
 

10.7.1. Saving the Project 
10.7.2. Exporting in JPG Format 
10.7.3. Exporting in PNG Format 

 

Note: Features marked with * marks are only for PRO version users. 
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10.1. Create Frame & Mask for 

Multi Photo Gift 
 
 
 

 To create a gift with particular design, we need to 
create frame for that gift. 
 

 
Frame for Gift 

 
 
 

10.1.1. Creating Frame 
 
 

 Measure the width and height of the actual frame with ruler. 
 

 According to the gift size, select the canvas area in the Photoshop. 
 

 Create outer border of the frame. 
 

 
Creating Frame 

 
 Save the created frame in PNG format. 

 
 Define the transparency of the frame to fit the photos in the desired mask. 
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Creating Frame 

 
 Save the frame in msk format.  

 
 
 
 
 
 

10.1.2. Creating Mask 
 
 

 Measure the width and height of the photo frame for individual masks. 
 

 Create mask only for odd shapes. 
 

 
Creating Mask 

 
 Create the mask according to the photos. 

 
 Save the mask in PNG format. 

 

Note: The file name of the frame in *.png and *.msk format should be similar Size and Name. 

 



 

 

www.dgflick.com Page 75 of 119 

 
Creating Mask 

 
 
 

10.1.3. Save the Masks & Frames in the Application Folder 
 
 

 Right click on the software folder. 
 

 
Saving Created Frame and Mask 

 
 Click on properties. 

 

 
Saving Created Frame and Mask - Properties Option 

 
 Click on Open File Location. 
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Saving Created Frame and Mask - Open File Location Option 

 
 Click on Products. 

 

 
Saving Created Frame and Mask - File Location Product Folder 

 
 Click on DgGift.  

 

 
Saving Created Frame and Mask - DgGift Folder 

 
 Click on Theme folder and paste the created frame in .png and .msk files in frame folder. 

 
 Click on Theme folder and paste the created mask in .png and .msk files in mask folder.  
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10.2. Create, Edit & Delete 

Category for Multi Photo 

Gift  
 
 
Gift Xpress has a wide variety of predefined categories for Gifts (refer section Predefined Categories and 
Sizes). However, you can create category and size according to design, edit it and delete as per your 
requirement. This section will let you know about creating, editing and deleting the categories in detail. 
 
 

10.2.1. Creating a Category 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 
‘Select Category’ window - Predefined Categories 

 
 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 

‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Click on the ‘Edit’ icon. You will see Add, Edit and Delete options. 
 

 Select the ‘Add’ option to add a new category in the ‘Select Category’ window.  
 

 On the next ‘Create Category’ window, Fill in the fields corresponding to the, 

o ‘Name’: The name you want for the new Category. 

o ‘Ref. Image’: The image you want for the Category, clicking on the ‘Browse’ icon  to the right of this 
field lets you choose the reference image from the path in which you saved it.  

o ‘Description’: Give a description of the category you are creating.  
 

Available 
categories ‘Edit’ icon 
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‘Create Category’ window – Adding Category 

 

 Click on ‘Save’ icon , on the lower right-hand corner to save the category you created.  
 

 
The New category added 

 

 The new category is created and can be viewed along with the predefined categories. 
 
 
 
 
 
 
 
 

 
 
 

10.2.2. Editing a Category 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Select the category you want to edit. Click on the ‘Edit’ icon. You will see Add, Edit and Delete options. 
 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By clicking 
on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. You could 
also click on ‘Home’ to go back to the home page. 
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‘Select Category’ window - Predefined Categories 

 
 Select the ‘Edit’ option to edit selected category in the ‘Select Category’ window.  

 

 
‘Edit Category’ window – Editing Category 

 
 On the next ‘Edit Category’ window, You can add the edits to the, 
 

o ‘Name’: Edit the name as per your choice. 

o ‘Ref. Image’: Change the image you want for the Category, clicking on the ‘Browse’ icon  to the right 
of this field lets you choose the reference image from the path in which you saved it.  

o ‘Description’: Change the description of the category as per your choice.  
 

 Click on ‘Save’ icon , on the lower right-hand corner to save the changes you made.  
 

 
 
 
 
 
 
 

 
 
 

10.2.3. Deleting a Category 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

Available 

categories ‘Edit’ icon 
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‘Select Category’ window - Predefined Categories 

 
 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 

‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Select the category you want to delete permanently. Click on the ‘Edit’ icon. You will see Add, Edit and 
Delete options. 
 

 Select the ‘Delete’ option to delete selected category in the ‘Select Category’ window.  
 

 A dialog box asking if you are sure, you want to delete category appears on the screen.  
 
 Clicking on ‘Yes’ deletes the category permanently; clicking on ‘No’ aborts the operation.  

 
 
 
 
 
  
 
 
 
 
 
 
 
  

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ 
command. You could also click on ‘Home’ to go back to the home page. 
 

Available 
categories ‘Edit’ icon 
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10.3. Create, Edit & Delete Size 

for Multi Photo Gift 
 
 
 
Apart from the categories, you can also create, edit and delete sizes in Gift Xpress. You get a freedom of 
Designing Gift in your own size. You can define your own custom Gift parameters. This section will let you 
know about creating, editing and deleting the predefined sizes in detail. 
 
 
 

10.3.1. Creating a Size 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 
‘Select Category’ window  

 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
 

 Select the category in which you want to add new size. Click on the  icon. Add, Edit and Delete icons will 
get visible. 
 

 Select the ‘Add’ icon to add a new size in the selected category.  
 

 On the next window: ‘Create Gift’ window, Fill in the fields corresponding to the, 
 
o ‘Name’: add new name for the new Gift size.  

 

 Icon 
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o ‘Ref. Image’: the image you want for your gift. Clicking on the icon  to the right of this field lets 
you choose the reference image from the path in which you saved it. 
 

o Define the Gift parameters under ‘Page’ tab. 
Units 
Width, height and DPI 
Margins (Left/Right/Top/Bottom) 
 

o Checking the ‘Export all photos as separate images’ check box will allow you to export all the images 
separately. 

 

 
The ‘Create Gift’ window 

 
o Checking the ‘Use Special Designs’ check box will allow you to view the designs in design area. 

 
o Check the ‘Export only Print Area’ to export only design area. 

 

o Give mirror effect to the output from the  option. 
 
o Define product details from ‘Product’ tab. 

 
o Check the ‘Use Product Image’ checkbox to insert the overlay image of the product. 

 

o Define the reference image, clicking on the icon  to the right of this field lets you choose the 
reference image from the path in which you saved it.  

 
o Check the ‘Export Product Image’ checkbox to export the overlay image of the product. 

 
 Click on ‘Save’ icon on the lower right-hand corner to save the size you created. 
 
 The new Gift size is created and can be viewed along with the other Gift sizes. 
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New size is created 

 
 
 
 
 
 
 
 

10.3.2. Editing a Size 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
 

 Select the size, which you want to edit. Click on the  icon. Add, Edit and Delete icons will get visible. 
 

 
‘Select Category’ window  

 
 Select the ‘Edit’ icon to edit selected size in the selected category.  
 
 On the next window: ‘Edit Gift’ window, Edit in the fields corresponding to the, 

 
o  ‘Name’: edit the name as per your choice. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

 Icon 
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o ‘Ref. Image’: the image you want for your gift. Clicking on the icon  to the right of this field lets 
you choose the reference image from the path in which you saved it. 
 

o Edit the Gift parameters under ‘Page’ tab. 
Units 
Width, height and DPI 
Margins (Left/Right/Top/Bottom) 
 

o Checking the ‘Export all photos as separate images’ check box will allow you to export all the images 
separately. 
 

 
The ‘Edit Gift’ window 

 
o Checking the ‘Use Special Designs’ check box will allow you to view the designs in design area. 

 
o Check the ‘Export only Print Area’ to export only design area. 

 

o Give mirror effect to the output from the  option. 
 
o Define product details from ‘Product’ tab. 

 
o Check the ‘Use Product Image’ checkbox to insert the overlay image of the product. 

 

o Define the reference image, clicking on the icon  to the right of this field lets you choose the 
reference image from the path in which you saved it.  
 

o Check the ‘Export Product Image’ checkbox to export the overlay image of the product. 
 
 Click on ‘Save’ icon on the lower right-hand corner to save the changes you made. 

 
 
 
 
 
 
 
 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
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10.3.3. Deleting a Size 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 
‘Select Category’ window 

 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
  

 Select the size, which you want to delete permanently. Click on the  icon. Add, Edit and Delete icons will 
get visible. 
 

 Select the ‘Delete’ icon to delete selected size in the selected category.  
 
 A dialog box asking if you are sure, you want to delete size appears on the screen. 
 
 Clicking on ‘Yes’ deletes the size permanently; clicking on ‘No’ aborts the operation. 

 
 
 
 
 
 
 
 
 
 
  

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

 Icon 
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10.4. Creating your Gift in 

Multi Photo Gift 
 
 
 
Let us see how this gift can be actually designed in Gift Xpress. 
 

 
‘Select Category’ window 

 
 Select the category and size you have created for Multi Photo Gift and start designing with ‘Next’ button. 

 
 You will be redirected to the ‘Design Gift’ window. 

 

 
‘Design Gift’ window 

 
 At the bottom side of the window, you will get various tabs that will help you to build the design. 

 
 Let us start with the border. To define the outline of the design, apply border to the canvas. Go to the 

‘Border’ tab. 
 

 To apply border, double click on the border or drag and drop the border needed from the ‘Border’ tab. 
 

‘Next’ button 
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'Design Gift' window – Border applied 

 
 Let us insert a dummy photo in the design that will take place of the actual photo. Go to the 'Photo' tab and 

open the folder from where you want to insert the dummy photo. 
 

 Double click on the photo to be inserted. The photo will appear on the page. 
 

 
Dummy photo added 

 
 Let us apply a mask on the photo to fit that photo in the area we want. 

 
 To apply the mask double click on the mask needed from the Left panel or drag and drop the mask. 

 
 To fit the photo in the photo area, scroll the mouse wheel to zoom in and zoom out on the photo. 

 

 For On-board Panning– Move the cursor on , the mouse pointer changes to  now click and drag. 
 

 Resize the Dummy Photo to fit in Photo Area. 
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Mask applied on dummy photo and resized as per design 

 
 Similarly insert other photos and masks. 

 

 
Other dummy photos and masks applied 

 
 Now Your Template with dummy photo is ready to save. 

 
 Template saving will help to design multiple articles in future without applying all the masks and save the 

resizing time. 
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10.5. Save & Build Templates 
 
 
 
 
 
Gift Xpress allow you to save a template and use it several times in future for instant gift designing. 
 
 

10.5.1. Save Template 
 
 

 Create the design and click on ‘Save’ option in the ‘Design’ tab to save the design.  
 

 In the textbox that appears, enter the design information pertaining to the parameters (except the 
parameter according to which the design has been filtered).  
 

 These include No. of Photos, Orientation, Color, Theme, Style and Custom. Depending on the number of 
photos used in the design, here the number of photos is detected automatically. You can also enter a name 
for your design in the ‘Template Name’ box. 

 

  
Design information while saving your design 

 
 Click on ‘Ok’ to proceed and on ‘Cancel’ to quit the process. 

 
 Template is saved as per the given information. 

 

 
Template saved 

 

‘Save’ 
option 
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10.5.2. Build Template 
 
 

 To proceed with the building of your designs, click on ‘Build’ in ‘Galleria’ menu.  
 

 
Building your design – 1 

 
 On the ‘Build’ window, select the designs and then click on ‘Build’ option. 
 
 In the text box that appears in next window, 

specify the name of the folder  in which you 

wish to save it and the path where you want to 
place it.  

Building your design - 2 
 

 If the path is not specified, the built volume is saved in the following path by default: My Documents\My 
Galleria\ Gift Xpress.  
  

 Check the box besides the ‘I agree to the terms and conditions’ and proceed by clicking on ‘Build’ .  
 
 
 
 

 A dialog box will appear which will inform you about successful buildup of designs. Click on the ‘OK’ button 
to continue with saving, else click on ‘Open’ to access the created design. 

 
 
 
 

 
 
 
  

! If you do not agree to the terms and conditions, close the textbox and quit the building process.  

 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. 
Note: Some features are available only for the Gift Xpress PRO version. 
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10.6. Get more & Import 

Templates 
 
 
 
You can maintain the template galleria in very fine way. 
 
 
 

10.6.1. Get More Template 
 
 

 DgFlick adds new design collection on the website on regular basis. You can add these designs to your 
software. 
 

 On ‘Design Gift’ window, Click on ‘Galleria’. Click on ‘Get More’ Button to access more designs from the 
DgFlick website.  
 

 You are now routed to www.dgflick.com from where you can download the designs of your choice and 
proceed to creating the Gift. 
 
 
 

10.6.2. Import Template 
 
 

 Gift Xpress software provides you the facility to use your own created or downloaded designs in design 
creation. 
 

 For that, you need to import your designs into the software. 
 

 On ‘Design Gift’ window, Click on ‘Galleria’. Click on ‘Import’ Button to Import designs.  
 

 Access the folder containing your designs by clicking 

on the ‘Browse’ button and selecting the location.  
 

 The 15 paths accessed immediately before this 
instance are saved in the path list box and can be 
accessed by clicking on the path. 
 

 Now select the designs from the location and click 
‘OK’ to import them to the ‘Design’ tab. Now you can 
apply the same in the Gift. 

 
The ‘Import’ window 

 
  

http://www.dgflick.com/
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10.7. Saving & Exporting Multi 

Photo Gift 
 
 
 

 You can create new Gift in new template. Go to the ‘Design’ Tab and insert newly created template. 
 

 Go to the ‘Photo’ tab and give the path of the photo folder. 
 

 Select the photo to be inserted on the page & double click on the photo. 
 

 To get the additional controls for managing photos, click on the ‘More’ icon . (For details, refer section 
Manage the Photos) 

 

 
The ‘Change Path’ window 

 

 You have the option of selecting the photos from the various available options . 
 

Hard disk  CD/DVD USB 
 

 You can make changes to the photos using the options listed at the bottom of the page. (for details refer 
Section Manage the photos) 
 

 Click on ‘Ok’ button  to go back to the ‘Design Gift’ window. 
 

 To use a photo, either double click on it or drag and drop it on the canvas. 
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Photos added to template 

 
 Save your project and export it in JPEG or PNG. 

 
 
 

10.7.1. Saving the Project 
 
 

 After the project is done, the next step is saving the project by clicking on ‘Save’ option. 
 

 
Saving Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 Save the Gift project with 'Save' option. 

 
 The default path for saving the project is 

displayed in the textbox as ‘My Documents \My 
Gifts’. You could either save the project in this 
path or provide the path of your choice to save 
the project.  
 

 Click on ‘Ok’ to save the project or on ‘Cancel’ to abort the process.  
 
 
 
 

'Save' 
option  
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10.7.2. Exporting in JPG Format 
 
 

 After the project is saved, the next step is exporting the project by clicking on ‘Save’ option. 
 

 
Exporting Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 To export the project in JPG format, select the ‘JPG’ option. 

 
 A window will appear. Assign a folder name for 

saving the JPG files. 
 

 The default path for saving the JPG file is ‘My 
Documents\My Exported Gifts’. However, you could 
change the path and save it in any location of your 
choice. 

 

 

 
 To access advance options for saving JPG, click on the ‘More’ option. Additional options will get visible. 

 
 Set the color profile by clicking on ‘Browse’ button. 

 
 To export the output as a mirror image, check the 

‘Mirror’ image. 
 

 You could optimize the quality or the file size by 
checking ‘Optimize Quality’ or ‘Optimize File Size’, 
as per your requirement.  

 
 

 Click on ‘Ok’ to proceed with the exporting or on ‘Cancel’ to abort the process. 
 

 Once the project has been exported, you get the confirmation in a dialog box. 
 

 The Gift saves its images separately according to the frame design. 
 
 
 
 
 

'Save' 
option  
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10.7.3. Exporting in PNG Format 
 
 

 After the project is saved, the next step is exporting the project by clicking on ‘Save’ option. 
 

 
Exporting Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 To export the project in printable PNG format, select the ‘PNG’ option. 

 
 A window will appear. 

 
 Assign a folder name for saving the PNG files. 

 
 

 The default path for saving the PNG file appears in the textbox. The path is ‘My Documents\My Exported 
Gifts’. However, you could change the path and save it in any location of your choice. 
 

 Click on ‘Ok’ to proceed with the exporting or on ‘Cancel’ to abort the process. 
 

 Once the project has been exported, you get the confirmation in a dialog box. 
 

 Here you can view the multi photo gift with photos in PNG format 
 
 
 
  

'Save' 
option  
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11.0. How to Create 

Special Design Gift? * 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

Gift Xpress software provides you the option of creating special design Gifts. In this section, 
we will learn how to create Special Design Gift with the Help of Gift Xpress. 

11.1. Create Frame & Mask for Special Design Gift 
 

11.1.1. Creating Frame 
11.1.2. Creating Mask 
11.1.3. Save the Masks & Frames in the Application Folder 

 

11.2. Create, Edit & Delete Category for Special Design Gift  
 

11.2.1. Creating a Category 
11.2.2. Editing a Category 
11.2.3. Deleting a Category 

 

11.3. Create, Edit & Delete Size for Special Design Gift 
 

11.3.1. Creating a Size 
11.3.2. Editing a Size 
11.3.3. Deleting a Size 

 

11.4. Creating your Gift in Special Design Gift 
 
11.5. Saving & Exporting Special Design Gift 

 

11.5.1. Saving the Project 
11.5.2. Exporting in JPG Format 
11.5.3. Exporting in PNG Format 

 
Note: Features marked with * marks are only for PRO version users. 
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11.1. Create Frame & Mask for 

Special Design Gift 
 
 
 

 You can create a Special Design Gift like shown in 
the image beside. 
 

 
 
 
 

11.1.1. Creating Frame 
 
 

 Measure the width and height of the gift size. 
 

 According to the gift size, select the canvas area in the Photoshop. 
 

 Create outer border of the frame. 
 

 Save the created frame in PNG format. 
 

 Measure the top, bottom, left and right area of the frame for creating mask. 
 

 Define these measurements in the Create new category window in Gift Xpress. 
 

 
Create Frame 

 
 
 

Note: The file name of the frame in *.png and *.msk format should be similar Size and Name. 
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11.1.2. Creating Mask 
 
 

 Create mask only for odd shapes. 
 

 Create the mask according to the photo placement area. 
 

 Save the mask in PNG format. 
 

 
Create Mask 

 
 Define the transparency of the mask to fit the photos in the desired shape or mask.  

 
 Save the mask in msk format.  

 
 
 
 

 Save the created frame in the application folder of Gift Xpress. 
 
 

11.1.3. Save the Masks & Frames in the Application Folder 
 
 

 Right click on the software folder. 
 

 
Saving Created Frame and Mask 

Note: The file name of the Frame in png and msk format should be similar. 

 



 

 

www.dgflick.com Page 99 of 119 

 
 Click on properties. 

 

 
Saving Created Frame and Mask - Properties Option 

 
 Click on Open File Location. 

 

 
Saving Created Frame and Mask - Open File Location Option 

 
 Click on Products. 

 

 
Saving Created Frame and Mask - File Location Product Folder 

 
 Click on DgGift.  
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Saving Created Frame and Mask - DgGift Folder 

 
 Click on Theme folder and paste the created frame in .png and .msk files in frame folder. 

 
 Click on Theme folder and paste the created mask in .png and .msk files in mask folder.  
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11.2. Create, Edit & Delete 

Category for Special 

Design Gift 
 
 
Gift Xpress has a wide variety of predefined categories for Gifts (refer section Predefined Categories and 
Sizes). However, in case the Special Design Gift, you can create category and size according to design, edit 
it and delete as per your requirement. This section will let you know about creating, editing and deleting 
the categories in detail. 
 
 

11.2.1. Creating a Category 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 
‘Select Category’ window - Predefined Categories 

 
 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 

‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Click on the ‘Edit’ icon. You will see Add, Edit and Delete options. 
 

 Select the ‘Add’ option to add a new category in the ‘Select Category’ window.  
 

 On the next ‘Create Category’ window, Fill in the fields corresponding to the, 

o ‘Name’: The name you want for the new Category. 

o ‘Ref. Image’: The image you want for the Category, clicking on the ‘Browse’ icon  to the right of this 
field lets you choose the reference image from the path in which you saved it.  

o ‘Description’: Give a description of the category you are creating.  

Available 
categories ‘Edit’ icon 
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‘Create Category’ window – Adding Category 

 

 Click on ‘Save’ icon , on the lower right-hand corner to save the category you created.  
 

 
The New category added 

 

 The new category is created and can be viewed along with the predefined categories. 
 
 
 
 
 
 
 
 

 
 
 

11.2.2. Editing a Category 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Select the category you want to edit. Click on the ‘Edit’ icon. You will see Add, Edit and Delete options. 
 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By clicking 
on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. You could 
also click on ‘Home’ to go back to the home page. 
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‘Select Category’ window - Predefined Categories 

 
 Select the ‘Edit’ option to edit selected category in the ‘Select Category’ window.  

 

 
‘Edit Category’ window – Editing Category 

 
 On the next ‘Edit Category’ window, You can add the edits to the, 
 

o ‘Name’: Edit the name as per your choice. 

o ‘Ref. Image’: Change the image you want for the Category, clicking on the ‘Browse’ icon  to the right 
of this field lets you choose the reference image from the path in which you saved it.  

o ‘Description’: Change the description of the category as per your choice.  
 

 Click on ‘Save’ icon , on the lower right-hand corner to save the changes you made.  
 

 
 
 
 
 
 
 

 
 
 

11.2.3. Deleting a Category 
 
 

 At the top of the screen, you see the available categories in the Gift Xpress. 
 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

Available 

categories ‘Edit’ icon 
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‘Select Category’ window - Predefined Categories 

 
 You get an ‘Edit’ icon at the end of the categories trail. If you do not see any ‘Edit’ icon, go to the 

‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The ‘Edit’ icon will get visible. 
 

 Select the category you want to delete permanently. Click on the ‘Edit’ icon. You will see Add, Edit and 
Delete options. 
 

 Select the ‘Delete’ option to delete selected category in the ‘Select Category’ window.  
 

 A dialog box asking if you are sure, you want to delete category appears on the screen.  
 
 Clicking on ‘Yes’ deletes the category permanently; clicking on ‘No’ aborts the operation.  

 
 
 
 
 
  
 
 
 
 
 
  

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ 
command. You could also click on ‘Home’ to go back to the home page. 
 

Available 
categories ‘Edit’ icon 
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11.3. Create, Edit & Delete Size 

for Special Design Gift 
 
 
 
Apart from the categories, you can also create, edit and delete sizes in Gift Xpress. You get a freedom of 
designing Gift in your own size. You can define your own custom Gift parameters such as Cover, Page and 
size. This section will let you know about creating, editing and deleting the predefined sizes in detail. 
 
 
 

11.3.1. Creating a Size 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 
‘Select Category’ window  

 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
 

 Select the category in which you want to add new size. Click on the  icon. Add, Edit and Delete icons will 
get visible. 
 

 Select the ‘Add’ icon to add a new size in the selected category.  
 

 On the next window: ‘Create Gift’ window, Fill in the fields corresponding to the, 
 
o ‘Name’: add new name for the new Gift size.  

 

 Icon 
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o ‘Ref. Image’: the image you want for your gift. Clicking on the icon  to the right of this field lets 
you choose the reference image from the path in which you saved it. 
 

o Define the Gift parameters under ‘Page’ tab. 
Units 
Width, height and DPI 
Margins (Left/Right/Top/Bottom) 
 

o Checking the ‘Export all photos as separate images’ check box will allow you to export all the images 
separately. 

 

 
The ‘Create Gift’ window 

 
o Checking the ‘Use Special Designs’ check box will allow you to view the designs in design area. 

 
o Check the ‘Export only Print Area’ to export only design area. 

 

o Give mirror effect to the output from the  option. 
 
o Define product details from ‘Product’ tab. 

 

 
‘Create Gift’ window – ‘Product’ tab 

 
o Check the ‘Use Product Image’ checkbox to insert the overlay image of the product. 

 

o Define the reference image, clicking on the icon  to the right of this field lets you choose the 
reference image from the path in which you saved it.  
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o Check the ‘Export Product Image’ checkbox to export the overlay image of the product. 

 
 Click on ‘Save’ icon on the lower right-hand corner to save the size you created. 
 
 The new Gift size is created and can be viewed along with the other Gift sizes. 
 

 
New size is created 

 
 
 
 
 
 
 
 

11.3.2. Editing a Size 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 

 

 
‘Select Category’ window  

 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

 Icon 
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 Select the size, which you want to edit. Click on the  icon. Add, Edit and Delete icons will get visible. 
 

 Select the ‘Edit’ icon to edit selected size.  
 
 On the next window: ‘Edit Gift’ window, Edit in the fields corresponding to the, 

 
o ‘Name’: edit the name as per your choice. 
 

o ‘Ref. Image’: the image you want for your gift. Clicking on the icon  to the right of this field lets 
you choose the reference image from the path in which you saved it. 
 

o Edit the Gift parameters under ‘Page’ tab. 
Units 
Width, height and DPI 
Margins (Left/Right/Top/Bottom) 
 

o Checking the ‘Export all photos as separate images’ check box will allow you to export all the images 
separately. 
 

 
The ‘Edit Gift’ window 

 
o Checking the ‘Use Special Designs’ check box will allow you to view the designs in design area. 

 
o Check the ‘Export only Print Area’ to export only design area. 

 

o Give mirror effect to the output from the  option. 
 
o Define product details from ‘Product’ tab. 

 
o Check the ‘Use Product Image’ checkbox to insert the overlay image of the product. 

 

o Define the reference image, clicking on the icon  to the right of this field lets you choose the 
reference image from the path in which you saved it.  
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‘Create Gift’ window – ‘Product’ tab 

 
o Check the ‘Export Product Image’ checkbox to export the overlay image of the product. 

 
 Click on ‘Save’ icon on the lower right-hand corner to save the changes you made. 

 
 
 
 
 
 
 
 
 

11.3.3. Deleting a Size 
 
 

 Whenever you select any category, available sizes are displayed in the ‘Select Category’ window.  
 

 
‘Select Category’ window 

 

 You get an  icon given at the bottom left corner of the window. If you do not see any icon, go to the 
‘Preferences’ and from the ‘View’ tab, check the ‘Edit Product Configuration’ checkbox and restart the 
software. The icon will get visible. 
  

 Select the size, which you want to delete permanently. Click on the  icon. Add, Edit and Delete icons will 
get visible. 

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
 

 Icon 
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 Select the ‘Delete’ icon to delete selected size in the selected category.  

 
 A dialog box asking if you are sure, you want to delete size appears on the screen. 
 
 Clicking on ‘Yes’ deletes the size permanently; clicking on ‘No’ aborts the operation. 

 
 
 
 
 
 
 
 
 
 
 
  

! At any point during the process, you could click on the ‘Back’ button to go back to the previous window. By 
clicking on this button, you are offered the chance to save/not save the changes or cancel the ‘Back’ command. 
You could also click on ‘Home’ to go back to the home page. 
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11.4. Creating your Gift in 

Special Design Gift 
 
 
 
Let us see how this gift can be actually designed in Gift Xpress. 
 

 
‘Select Category’ window 

 
 Select the category and size you have created for Special Design Gift and start designing with ‘Next’ button. 

 
 You will be redirected to the ‘Design Gift’ window. 

 

 
‘Design Gift’ Window 

 
 At the bottom side of the window, you will get various tabs that will help you to build the design. 

 
 Go to the ‘Photo’ tab and give the path of the photo folder. 

 
 Select the photo to be inserted on the page & double click on the photo. 

 

 To get the additional controls for managing photos, click on the ‘More’ icon . (For details, refer section 
Manage the Photos) 

‘Next’ button 
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The ‘Change Path’ window 

 

 You have the option of selecting the photos from the various available options . 
 

Hard disk  CD/DVD USB 
 

 You can make changes to the photos using the options listed at the bottom of the page. (for details refer 
Section Manage the photos) 
 

 Click on ‘Ok’ button  to go back to the ‘Design Gift’ window. 
 

 To use a photo, either double click on it or drag and drop it on the canvas. 
 

 
Photos added to design 

 
 Save your project and export it in JPEG or PNG. 
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11.5. Saving & Exporting 

Special Design Gift 
 

 
 Save project for future editing and exporting. 

 
 
 

11.5.1. Saving the Project 
 
 

 After the project is done, the next step is saving the project by clicking on ‘Save’ option. 
 

 
Saving Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 Save the Gift project with 'Save' option. 

 
 The default path for saving the project is 

displayed in the textbox as ‘My Documents \My 
Gifts’. You could either save the project in this 
path or provide the path of your choice to save 
the project.  

 
 Click on ‘Ok’ to save the project or on ‘Cancel’ to abort the process.  

 
 
 

11.5.2. Exporting in JPG Format 
 
 

 After the project is saved, the next step is exporting the project by clicking on ‘Save’ option. 
 

'Save' 
option  
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Exporting Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 To export the project in JPG format, select the ‘JPG’ option. 

 
 A window will appear. Assign a folder name for 

saving the JPG files. 
 

 The default path for saving the JPG file is ‘My 
Documents\My Exported Gifts’. However, you could 
change the path and save it in any location of your 
choice. 

 

 

 
 To access advance options for saving JPG, click on the ‘More’ option. Additional options will get visible. 

 
 Set the color profile by clicking on ‘Browse’ button. 

 
 You could optimize the quality or the file size by 

checking ‘Optimize Quality’ or ‘Optimize File Size’, 
as per your requirement.  
 

 To export the output as a mirror image, check the 
‘Mirror’ image. 

 
 

 Click on ‘Ok’ to proceed with the exporting or on ‘Cancel’ to abort the process. 
 

 Once the project has been exported, you get the confirmation in a dialog box. 
 

 The Gift saves its images separately according to the frame design. 
 

 The gift gets saved as Special Design Gift.JPEG 
 
 
 

11.5.3. Exporting in PNG Format 
 
 

 After the project is saved, the next step is exporting the project by clicking on ‘Save’ option. 
 

'Save' 
option  
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Exporting Gift 

 
 You get different options here. Save, JPG and PNG.  

 
 To export the project in printable PNG format, select the ‘PNG’ option. 

 
 A window will appear. 

 
 Assign a folder name for saving the PNG files. 

 
 

 The default path for saving the PNG file appears in the textbox. The path is ‘My Documents\My Exported 
Gifts’. However, you could change the path and save it in any location of your choice. 
 

 Click on ‘Ok’ to proceed with the exporting or on ‘Cancel’ to abort the process. 
 

 Once the project has been exported, you get the confirmation in a dialog box. 
 

 Here you can view the Special Design Gift with photos in PNG format 
 

 The gift is saved as Special Design Gift.PNG. 
 
 
  

'Save' 
option  
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12.0. Open Saved Project 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Gift Xpress 

Gift Xpress gives you the great advantage of opening and editing the saved projects as many 
times as you want. 
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 To open a project that has been saved and exported, click on the Home icon of Gift Xpress. 

 
 You will be redirected to Home page where you can see ‘Open’ option at left bottom side. 

 
 Click on ‘Open’ option. 

 
 The projects you have saved are now displayed 

on the screen. 
 

 Through ‘Browse’ icon, you can give path of the 
folder where you have saved your project. 
 

 Select the project you wish to work on and then 
click on ‘Open’. 

 

   
 The saved projects on the path 
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13.0. Troubleshoot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  

Gift Xpress 

This section deals with questions most commonly encountered by Gift Xpress users. 

 How many times I can install the software on the same machine? 
Ans: You can install the software on the same machine for as many times as you needed. 

 
 Can I install the software from the same DVD/CD on MAC as well as on Windows? 

Ans: The installation DVD/CD comes with dual installation setup files of both MAC & Windows, so 
you can easily install on both operating systems with the same DVD/CD.  

 
 Can I create my own Designs? 

Ans: Yes, You can create Designs of your own choices. Software gives you complete freedom to 
create and save * your creations. 
 
Can I get create sublimation gifts in Gift Xpress? 
Ans: Yes. Gift Xpress supports sublimation gift designing. Even, it can create mirror output in single 
click. 

Note: Some features are available only for the Gift Xpress PRO version users. 
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For additional support or clarification, please contact DgFlick 
offices/support via: 

 
 

DgFlick LLC,  
 
30 Knightsbridge Rd, 
Suite 525, 
Piscataway, 
NJ 08854 
 
Email: support@dgflick.com  
Telephone: India +91 22 2968 68 68,  

     US +1-732-543-7676. 
 
 

mailto:support@dgflick.com

